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Documentation disclaimer
Avaya shall  not be responsible for any modifications, additions, or deletions to
the original published version of this documentation unless such modifications,
additions, or deletions were performed by Avaya.

End User agree to indemnify and hold harmless Avaya, Avaya's agents,
servants and employees against all claims, lawsuits, demands and judgments
arising out of, or in connection with, subsequent modifications, additions or
deletions to this documentation, to the extent made by End User.

Link disclaimer
Avaya is not responsible for the contents or reliability of any linked Web sites
referenced  within this site or documentation(s) provided by Avaya.  Avaya is
not responsible for the accuracy of any information, statement or content
provided on these sites and  does not necessarily endorse the products,
services, or information described or offered within them. Avaya does not
guarantee that these links will work all the time and has no control over the
availability of the linked pages.

Warranty
Avaya provides a limited warranty on this product. Refer to your sales
agreement to establish the terms of the limited warranty. In addition, Avaya’s
standard warranty language, as well as information regarding support for this
product, while under warranty, is available to Avaya customers and other
parties through the Avaya Support Web site: http://www.avaya.com/support.
Please note that if you acquired the product from an authorized Avaya reseller
outside of the United States and Canada, the warranty is provided to you by
said Avaya reseller and not by Avaya.

Licenses
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ARE INSTALLING, DOWNLOADING OR USING THE SOFTWARE (HEREINAFTER
REFERRED TO INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING CONTRACT
BETWEEN YOU AND AVAYA INC. OR THE APPLICABLE AVAYA AFFILIATE
(“AVAYA”).

Avaya grants End User a license within the scope of the license types described
below. The applicable number of licenses and units of capacity for which the
license is granted will be one (1), unless a different number of licenses or units
of capacity is specified in the Documentation or other materials available to
End User. "Designated Processor" means a single stand-alone computing
device. "Server" means a Designated Processor that hosts a software
application to be accessed by multiple users. "Software" means the computer
programs in object code, originally licensed by Avaya and ultimately utilized by
End User, whether as stand-alone products or pre-installed on Hardware.
"Hardware" means the standard hardware originally sold by Avaya and
ultimately utilized by End User.

License types
Designated System(s) License (DS). End User may install and use each copy of
the Software on only one Designated Processor, unless a different number of
Designated Processors is indicated in the Documentation or other materials
available to End User. Avaya may require the Designated Processor(s) to be
identified by type, serial number, feature key, location or other specific
designation, or to be provided by End User to Avaya through electronic means
established by Avaya specifically for this purpose.

Copyright
Except where expressly stated otherwise, no use should be made of materials
on this site, the Documentation(s) and Product(s) provided by Avaya. All
content on this site, the documentation(s) and the product(s) provided by
Avaya including the selection, arrangement and design of the content is owned
either by Avaya or its licensors and is protected by copyright and other
intellectual property laws including the sui generis rights relating to the
protection of databases. You may not modify, copy, reproduce, republish,
upload, post, transmit or distribute in any way any content, in whole or in part,
including any code and software.  Unauthorized reproduction, transmission,
dissemination, storage, and or use without the express written consent of
Avaya can be a criminal, as well as a civil, offense under the applicable law.

Third Party Components 
Certain software programs or portions thereof included in the Product may
contain software distributed under third party agreements ("Third Party
Components"), which may contain terms that expand or limit rights to use
certain portions of the Product ("Third Party Terms"). Information regarding
distributed Linux OS source code (for those Products that have distributed the
Linux OS source code), and identifying the copyright holders of the Third Party
Components and the Third Party Terms that apply to them is available on the
Avaya Support Web site: http://support.avaya.com/Copyright.

Preventing toll fraud
"Toll fraud" is the unauthorized use of your telecommunications system by an
unauthorized party (for example, a person who is not a corporate employee,
agent, subcontractor, or is not working on your company's behalf). Be aware
that there can be a risk of toll fraud associated with your system and that, if
toll fraud occurs, it can result in substantial additional charges for your
telecommunications services.

Avaya fraud intervention
If you suspect that you are being victimized by toll fraud and you need
technical assistance or support, call Technical Service Center Toll Fraud
Intervention Hotline at +1-800-643-2353 for the United States and Canada.
For additional support telephone numbers, see the Avaya Support Web site:
http://support.avaya.com
Suspected security vulnerabilities with Avaya products should be reported to
Avaya by sending mail to: securityalerts@avaya.com.

Trademarks
Avaya and Aura are trademarks of Avaya, Inc.
The trademarks, logos and service marks (“Marks”) displayed in this site, the
documentation(s) and product(s) provided by Avaya are the registered or
unregistered Marks of Avaya, its affiliates, or other third parties.  Users are not
permitted to use such Marks without prior written consent from Avaya or such
third party which may own the Mark. Nothing contained in this site, the
documentation(s) and product(s) should be construed as granting, by
implication, estoppel, or otherwise, any license or right in and to the Marks
without the express written permission of Avaya or the applicable third party.
Avaya is a registered trademark of Avaya Inc. All non-Avaya trademarks are
the property of their respective owners.

Downloading documents
For the most current versions of documentation, see the Avaya Support Web
site: http://www.avaya.com/support

Contact Avaya Support
Avaya provides a telephone number for you to use to report problems or to
ask questions about your product. The support telephone number is
1-800-242-2121 in the United States. For additional support telephone
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What is new in 8.0
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What is new in 8.0:  

1. What is new in 8.0
The following functionality has been added to Voicemail Pro 8.0.

· International Time Zone support
The International Time Zone (ITZ) support is now available on the central Voicemail Pro server and the distributed
Voicemail Pro servers that are connected to the IP Offices located in different time zones across the globe.
Note: When you upgrade Voicemail Pro to a newer version, the Voicemail Pro server updates the current time zone
offset of the user. However, it does not update the campaign information.

· Exchange Integration support on Linux
Exchange Integration is now available for Voicemail Pro on Linux. To set up Exchange Integration for Voicemail Pro on
Linux, the Administrator needs to install a new MAPI proxy service that provides the communication layer between
Voicemail Pro on Linux and the Exchange server. The Administrator must install the MAPI proxy service on a Windows
computer that can communicate with the Exchange server. The Windows computer can be an Exchange server
computer using the Messaging API (MAPI) that is shipped with the Exchange server. If the MAPI proxy service is
installed on any other Windows computer, then the Administrator can use Microsoft Outlook to communicate to the
Exchange server.
Note: 
1. Starting with Exchange Server 2007, the MAPI is not shipped with the Exchange server but can be installed
separately. For details, see http://support.microsoft.com/kb/945835.
2. Microsoft does not support installing Exchange Server components and Microsoft Outlook on the same computer.
For details, see http://support.microsoft.com/kb/266418.

· Unified Communications Module
A Linux-based Voicemail Pro server is pre-installed on Unified Communications Module and is operational with the
default Preferred Edition license. Some of the behaviors of a Voicemail Pro server installed on Unified Communications
Module are different from a standard Linux-based Voicemail Pro server. See UC Module Voicemail Pro  for details.

· Conference Call Center Support Removal
Voicemail Pro no longer supports Conferencing Center telephony action and, therefore, the Conferencing Center will no
longer be available as an action. If a user imports or opens a call flow containing the Conferencing Center actions, the
system displays a warning message that the call flow contains an unsupported action. If the user does not take any
action on the call flow that contains a Conferencing Center action, Voicemail Pro will disconnect the call reaching this
action. Restoring a call flow containing the Conferencing Center action will log the name of the unsupported action and
the call flow name where it was found. The log file can be found at <Installation path>\VMPro_Restore.log.

16
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Voicemail Pro

Chapter 2.
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2. Voicemail Pro
The diagram illustrates a Voicemail Pro system with some of the setup options. 

· IP Office Control Unit 
The IP Office Voicemail Pro licenses  are entered into the configuration of the IP Office system. The licenses are
required to activate Voicemail Pro features. You can run an unlicensed Voicemail Pro service for demonstration and
testing for a duration of two hours only. License keys are issued against and validated against the unique serial
number of the feature key dongle used by the IP Office. 

· Voicemail Pro Server 
The Voicemail Pro service is installed on a server computer. This becomes the computer where messages and other
data are stored for the mailboxes and services provided by Voicemail Pro. The server can be a Windows or Linux
based server. 

· Multiple Servers 
There are a number of scenarios where multiple Voicemail Pro servers can be supported. For example, to
provide a backup voicemail server or to support multiple IP Office systems in a network. See Centralized
Voicemail Pro . 

· Voicemail Pro Client
The Voicemail Pro Client is used to administer the Voicemail Pro service. The client is a Windows application that
you can install on another computer to allow remote administration of the server. Only one client can connect to
the server at any time. 

· The version of a Voicemail Pro client used with a Voicemail Pro server should match. If the Voicemail Pro client
is used to load a call flow from an earlier version of Voicemail Pro server, you will be warned that if you edit the
call flow you will not be able to save it back to the original server. If the client is used to load a call flow from a
later version of Voicemail Pro server it will stop the action and prompt that the call flow cannot be loaded.

· Telephone Extension 
For internal extensions, the voicemail server provides message waiting indication. This is done automatically for the
telephone user's own mailbox. However, the user can also be configured to receive message waiting indication for
other mailboxes. 

· User's Computer 
In addition to accessing mailbox voicemail messages through the telephone, there is a range of methods for
accessing messages from a user's computer. This can be by web browser, IMAP e-mail account, Exchange server e-
mail account, and various other options. The IP Office one-X Portal for IP Office and IP Office Phone Manager
applications can also be used. 

· E-mail Server 
Using an e-mail server, Voicemail Pro can provide a number of services. This includes the ability to send message
alerts or message copies. For Exchange e-mail servers, with the forward to e-mail option, the Exchange server can
be used as the message store with users accessing their messages using Exchange clients such as Microsoft
Outlook, Outlook Web Access, and so on. 

12
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Voicemail Pro:  

2.1 Supported Languages
By default, the prompts installed match the installer language selection plus English. If other languages are required,
they need to be selected by doing a custom installation. The installable Voicemail Pro prompts are listed in the table
below. The availability of a language in voicemail does not necessarily indicate support for IP Office in a country that uses
that language. 

Language WAV
Folder

Fallback
Selection

TTS 

Linux

Brazilian Portuguese ptb > pt > en.

Chinese (Cantonese) zzh > en > enu.

Chinese (Mandarin) ch > en > enu.

Danish da > en.

Dutch nl > en.

English UK en > en.

English US enu > en.

Finnish fi > en.

French fr > frc > en.

French Canadian frc > fr > enu > en.

German de > en.

Greek el > en.

Hungarian hu > en.

Italian it > en.

Korean ko > en.

Latin Spanish eso > es > enu >
en.

Norwegian no > en.

Polish pl > en.

Portuguese pt > ptb > en.

Russian ru > en.

Spanish es > eso > en.

Swedish sv > en.

Note: If you are using Voicemail Pro installed on Unified Communications Module, see Languages Supported on UC
Module Voicemail Pro .

When the IP Office routes a call to the voicemail server, it indicates the locale for which matching prompts should be
provided, if available. Within the IP Office configuration, a locale is always set for the system. However, differing locales
can be set for each user, incoming call route, and short codes in addition to the default system locale. 

The locale sent to the voicemail server by the IP Office is determined as follows:

Locale Source Usage

Short Code Locale The short code locale, if set, is used if the call is routed to
voicemail using the short code. 

System Locale If no user or incoming call route locale is set, system locale
is used, unless overridden by a short code locale. 

Incoming Call Route Locale The incoming call route locale, if set, is used if the caller is
external.

User Locale The user locale, if set, is used if the caller is internal.

If the prompts matching the IP Office locale are not available, the voicemail server will provide prompts from a fallback
language, if available. The above table of languages lists the order of fallback selection. 

If required, the language provided by a voicemail call flow can be changed using a  Select System Prompt
Language action.

TTY Teletype Prompts
TTY (Teletype (Textphone)) is included in the list of installable languages. TTY is a text-based system that is used to
provide services to users with impaired hearing.

16
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2.2 Voicemail Pro Licenses
The Help | About screen in the voicemail client can be used to check which IP Office the voicemail server is working and
the licenses it has received from that IP Office. 

The license keys are entered into the IP Office configuration using the IP Office Manager. If the Voicemail Pro server is
installed without licenses, it will run for 2 hours and then shut down.

For IP Office Release 6 and higher, support for Voicemail Pro is enabled by the addition of a Preferred Edition license. 

·  Preferred Edition (Voicemail Pro) : 
This license enables support for Voicemail Pro as the IP Office's voicemail server with four voicemail ports. The
voicemail server with the Preferred Edition license provides the services listed below. Additional licenses can be
added for additional voicemail features, these are detailed separately. The Preferred Edition license was previously
called Voicemail Pro (4 ports). 

· Mailboxes for all users and hunt groups. 

· Announcements for users and hunt groups. 

· Customizable call flows. 

· Call recording to mailboxes. 

· Campaigns. 

· TTS e-mail reading for users
licensed for Mobile User or Power
User profiles.

· Use of Conference Meet Me
functions on IP500 and IP500 V2
systems. 

·  Advanced Edition 
The Advanced Edition license enables the additional features listed below. A Preferred Edition license is a pre-
requisite for the Advanced Edition license. 

· Support for Customer Call Reporter. 

· Voicemail Pro database interaction (IVR).

· Voicemail Pro Visual Basic Scripting. 

· Voicemail Pro call recording to
ContactStore.[1]

1.In a Small Community Network using centralized voicemail, this license only enables ContactStore support for
the central IP Office. Remote IP Offices in the network require their own Advanced Edition license or a VMPro
Recordings Administrator license. 

·  Preferred Edition Additional Voicemail Ports 
The required license for Voicemail Pro server support (Preferred Edition (Voicemail Pro)) also enables four voicemail
ports. This license can be used to add additional voicemail ports up to the maximum capacity of the IP Office
system (IP406 V2 = 20, IP412 = 30, IP500 = 40, IP500 V2 = 40). This license was previously called Additional
Voicemail Pro (ports).
Note: If you are using Voicemail Pro installed on Unified Communications Module, see Number of Simultaneous
Users on UC Module Voicemail Pro  for the maximum capacity of the IP Office system.

·  VMPro Recordings Administrators : 
To support ContactStore in a Small Community Network, IP Offices other than the central IP Office require either
their own Advanced Edition license or this license. 

·  VMPro Networked Messaging : 
Enables the VPNM (Voicemail Pro Networked Messaging) functionality within Voicemail Pro. Enabling VPNM is
required for message exchange with remote Voicemail Pro systems and Avaya Interchange systems. 

·  VMPro TTS Professional :  
Enables use of all text to speech facilities provided by Voicemail Pro. One license per simultaneous instance of TTS
usage.

Note: If you plan to use Voicemail Pro installed on Unified Communications Module for centralized voicemail, also see
Storage Space for Call Recordings on UC Module Voicemail Pro .

16
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Voicemail Pro: Voicemail Pro Licenses

Legacy Licenses
The following legacy licenses are still supported by IP Office Release 6 and higher. 

·  UMS Web Services 
This legacy license is used to enable UMS voicemail services support for users set to the Basic User profile.
Other users are enabled for UMS through their licensed user profile. 

·  VMPro Database Interface : 
This legacy license enables 3rd party database support within Voicemail Pro call flows. For IP Office Release 6
and higher, this is also enabled by the Advanced Edition license. 

·  VMPro VB Script :  
This legacy license enables Visual Basic Script support with Voicemail Pro. For IP Office Release 6 and higher,
this is also enabled by the Advanced Edition license. 

2.3 Number of Simultaneous Users
All connections between the voicemail server and the IP Office are through LAN using data channels. The maximum
number of data channels that can be used for voicemail operation at any moment are shown below. 

IP Office Maximum for
Voicemail Pro

IP500 40

IP500 V2 40

The actual number of simultaneous users is determined by the licenses for Voicemail Pro  added to the IP Office
configuration. Note that some specific functions can have voicemail channels reserved  for their use or can have
channel restrictions. 

Note: If you are using Voicemail Pro installed on Unified Communications Module, see Number of Simultaneous Users on
UC Module Voicemail Pro .

12
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Installation

Chapter 3.
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3. Installation
Linux Server Installation

A Voicemail Pro server is one of the Linux components installable as part of the IP Office Application Server DVD
installation. That process is covered separately in the IP Office Application Server documentation. 

· The license requirements  on the IP Office system for supported voicemail features are the same. 

· Configuration of the IP Office configuration  settings for voicemail is not affected by whether the server is
Windows or Linux based. 

· Configuration of the voicemail server setting is still done using the Windows based Voicemail Pro client application.
The client can be downloaded from the Linux server for installation on a Windows client computer. 

Mixing Linux and Windows Servers
In scenarios where multiple Voicemail Pro servers are used, see Centralized Voicemail Pro, a mix of Linux and Windows
based servers can be used. 

Linux Server Feature Support

For a Voicemail Pro 8.0 server running on a Linux based server, the following Voicemail Pro features are currently not
supported: 

· VB Scripting.

· VPNM.

· 3rd Party Database Integration.

· VRLA.

When logged into the voicemail server using the Voicemail Pro client, the features that are not supported are grayed out
or hidden. If those features are present in an imported call flow, they will not function and calls that attempt to use those
features will be disconnected. 

For Small Community Network scenarios where multiple voicemail servers are present, for example distributed and
backup server, a mix of Linux based and Windows based servers are supported. 

UC Module Voicemail Pro
A Linux-based Voicemail Pro server is pre-installed on Unified Communications Module and is operational with the default 
Preferred Edition license. However, the following behaviors of a Voicemail Pro server installed on Unified
Communications Module are different from a standard Linux-based Voicemail Pro server.

· Supported Languages
Only the English US and English UK languages are supported for Text to Speech (TTS). 

· Accessing Voicemail Pro Server
To access the Voicemail Pro server running on Unified Communications Module, use the IP address or the DNS
name of the IP Office control unit that hosts Unified Communications Module.

· Backup and Restore Settings 
Backup files can be saved on a USB storage. The available file paths for the USB storage are /media/sdb1 and /
media/sdc1. As the storage space available on UC Module SSD is limited and primarily required for saving call
recordings, use a USB storage for the backups.

· Voicemail Pro Logging Level
The default logging level is set to Critical.

· Number of Simultaneous Users
The maximum number of data channels that can be simultaneously used for voicemail operation is 40. However, if
one-X is also enabled on Unified Communications Module, the maximum number of data channels that can be used
simultaneously may reduce to 20.

· Storage Space for Call Recordings
Voicemail call recordings use an approximate storage space of 1 Mb for each minute of recording. Therefore, the
available storage space on UC Module SSD is limited to an estimated  maximum of 400 hours of call recordings.
Consider this fact if you plan to use the Voicemail Pro server installed on Unified Communications Module for
centralized voicemail.

· Voicemail IP Address
IP Office hosting Unified Communications Module connects to the Voicemail Pro server installed on the card by
default. The IP address of the Voicemail Pro server is automatically detected and cannot be modified.

3.1 General Installation Requirements
Here is a list of general requirements for all types of voicemail installation. 

· A client computer with IP Office Manager and Microsoft .NET Framework versions 2.0 installed on it. If .NET 2.0 is
not detected, you will be prompted to install it before the Voicemail Pro installation proceeds.

· An IP Office Feature Key. Refer to Avaya IP Office Standard Version Installation (15-601042) for details. 

· Licenses based on the serial number of the IP Office Feature Key. These should include: 

12
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Installation: General Installation Requirements

· A license for Voicemail Pro and any additional voicemail ports is required. If Voicemail Pro Server is installed
without a license it will run for two hours and then shut down.

· Licenses for any other Voicemail Pro components being installed, see Voicemail Pro Licenses .

· IP Office Applications DVD. 

 

Tips

· Before you begin to install Voicemail Pro, check that the computer that you are using can connect to the IP Office
unit and that you can load and save a configuration file using IP Office Manager.

· Switch off any computer and hard disk sleep, power down, suspend, hibernation modes.

12
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3.1.1 Computer Specifications
The Voicemail Pro application requires various licenses entered into the IP Office configuration to control the features it
offers and the number of simultaneous connections , up to 40 on IP Office 5.0+ IP500 control units. The operation of
Voicemail Pro can be customized to provide special services.

The Voicemail Pro software can be installed as separate Voicemail Pro client and server parts. You can perform remote
administration of the Voicemail Pro server from a computer with just the Voicemail Pro client installed. A copy of the
client is automatically installed locally with the Voicemail Pro server.

Source

DVD IP Office 8.0 Application DVD (Disk 1)

Languages See Supported Languages .

IP500  IP Office Standard Edition[1],  IP Office Professional Edition.

License  See below.

1.For pre-IP Office 5.0 IP500 systems, an IP500 Upgrade Standard to Professional licenses is required to support
Voicemail Pro. 

The Voicemail Pro server part of the software consists of Text to Speech (TTS) in addition to the core server software.
Through adding additional licenses, Voicemail Pro can use the TTS functions to speak text and numbers to callers in
addition to recording prompts. This is intended mainly for scenarios where Voicemail Pro is obtaining text and number
values from a customer database.

 

Notes:

1. Do not use the Large Fonts setting, as it may cause options on some screens to become inaccessible.

2. For a good connection speed, use a 100 Mbps network card.

3. Free disk space requirements  are also subject to the message storage required. 

13
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Installation: General Installation Requirements

For information on computer specification and other requirements, see  IP Office Application Server documentation



Implementing Voicemail Pro on Linux Page 20
15-601065 Issue 02b (Friday, April 06, 2012)IP Office 8.0

Ports
The Voicemail Pro service uses the following ports. 

Port
Number

Type Description

25 TCP Used to listen for SMTP connections.

37 UDP Used to receive time requests (RFC 868).

143 TCP Used to service IMAP4 requests.

50791 UDP Used to receive requests from IP Office PBX.

TCP Used to receive requests from one-X Portal for IP
Office.

50791 TCP Used to receive connections from Voicemail Pro
client.

Note that Voicemail may use additional ports for connection to services such as 3rd party database or Microsoft
Exchange. 

3.1.2 Virtual Server Support
Operation of IP Office server applications, including Voicemail Pro, is supported using the following virtual servers. 

· VMWare Server. 

· Microsoft Virtual Server 2005 R2. 

· Microsoft Server Hyper-V.

3.1.3 Network Requirements
 For information on network requirements for installation on Linux, see  IP Office Application Server documentation.
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Installation: General Installation Requirements

3.1.4 Disk Space Requirements
The following are only approximations: 

· At least 5GB of free disk space is required on the operating system drive , regardless of to which drive Voicemail
Pro is actually installed.

· A compact Voicemail Pro installation requires 300MB or more. 

· A typical installation requires approximately 255MB. 

· A custom installation requires up to 5GB (for all supported languages) of disk space. However, prompts and
recorded messages consume an additional 1MB of disk space per minute.

· For a busy environment you can expect to require at least 1000 minutes of message recording space, that is 1GB.

3.2 Server/Client Installation
 You can install only the client using the Voicemail Pro installation software for Linux. 

Component Sub Component

Client

Voicemail Pro Voicemail Pro Client

Voicemail Pro Service

Languages

Voicemail Pro Campaign Web
Component

Web Voicemail (UMS)

Before you begin:

1.Log on to the server computer using the account under which you intend the Voicemail Pro server or service to run.
This account must have full administrator rights to the server computer. If you prefer, create a new user account
called Voicemail and configure it such that it has full administrator rights on the computer and the account
password does not expire. 

2.In IP Office Manager, check that the correct licenses for Voicemail Pro  have been installed and show a status of
Valid. 

3.For installations other than client only and compact, check that the required pre-installation processes have been
completed. 

· Voicemail E-mail Installation

· Installing Text to Speech Features

12
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To install the Voicemail Pro software components:

For more information on installing the Voicemail Pro software components on Linux, see IP Office Application Server
documentation.

· Voicemail E-mail Installation

· Installing Text to Speech Features

3.2.1 Modifying the Installed Components
Deletion of installed components is not supported on Linux.

23
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Installation: Server/Client Installation

3.2.2 The Voicemail Pro Services

The IP Office application services installed on the IP Office Application Server can be started and stopped individually.
This is required for maintenance or if a particular service is not currently needed, for example, if one-X Portal for IP
Office has been installed but is not currently licensed.

The services can be set to automatically start after a server reboot. By default, all the IP Office services are automatically

started.

Starting a Service
1. Log in to the IP Office Application Server Web configuration pages.

2. Select Home (this is selected by default after logging in). The services and their current status (running or stopped)
are listed.

3. To start a particular service click on the Start button next to the service. To start all the services that are not

currently running, click on the Start All button.

For more information on starting and stopping Application Services see, IP Office Application Server documentation. 

3.3 Voicemail Email
Voicemail E-mail features of the voicemail server provide a number of e-mail functions: 

· Forward a Message to E-mail 
If the voicemail server is set to IP Office mailbox mode, mailbox users are able to manually forward an voicemail
message to their e-mail. 

· Automatic New Voicemail Messages 
For all mailbox modes, users can use voicemail e-mail to automatically have a message sent to their e-mail
whenever they receive a new voicemail message. The e-mail can be a simple alert or it can include a copy of the
voicemail as an attachment. 

· eMail Action 
With customized call flows, an eMail action can be used to send a caller's recorded voicemail message to a
specified e-mail address.

· UMS Exchange
In conjunction with Exchange server and Microsoft Outlook, users are able to use their Outlook inbox as their
mailbox for voicemail messages. If the Exchange server is 2007/2010 and the mailbox is configured for Unified
Messaging, the users will also have the ability to play the message within Outlook, if using Microsoft Outlook
2007/2010.

Voicemail E-mail features requires the voicemail server to be configured for access to either an SMTP e-mail server or to
a MAPI e-mail server via a MAPI enabled e-mail client program on the voicemail server computer.

· SMTP Installation  
This is an e-mail standard supported by most e-mail servers. It is the default e-mail mode for the voicemail
server. 

· MAPI Installation  
MAPI requires a MAPI compliant e-mail client program to be installed on the Voicemail Pro server.  It also requires
the Voicemail Pro service to be run using a user account that is able to send e-mails via that MAPI client. 

· The exact method of integration between the voicemail server and the MAPI e-mail client depends on whether
the voicemail server is part of a work group or a domain. This guide contains examples for both approaches.

 

 

24

28



Implementing Voicemail Pro on Linux Page 24
15-601065 Issue 02b (Friday, April 06, 2012)IP Office 8.0

3.3.1 SMTP Setup

To configure the server SMTP e-mail settings:

1.Start the Voicemail Pro Client.

2.Click  Preferences and select General.

3.Click the Email tab.

4.Verify that there are no settings on the MAPI sub tab. 

5.Enter the SMTP settings on the SMTP Sender  sub tab. These are the settings that the voicemail server uses for
sending SMTP e-mails. 

· Logging 
If selected, SMTP logging  by the server is enabled. 

· Servers 
This section is used to enter details of the SMTP server or servers to which the voicemail server send its

messages. 
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Installation: Voicemail Email

To add a server, click on the . icon. To edit the server, click on the  icon. To delete a server entry, click on . 

· Mail Domain 
This field is used differently depending on whether it is the first entry in the list or not: 

· For the first server entry in the list: 
This is the default outgoing e-mail settings. It also sets the mail destination domain on which the voicemail
server filters incoming messages (see below) and so is repeated on the SMTP Receiver  tab. 

· Messaging Between Voicemail Servers 
For messaging between voicemail servers, the first entry in the SMTP Sender list must be the one
configured and used. Each server uses the SMTP server service on the same server computer as the
voicemail service. For example a Windows based servers uses the SMTP e-mail provided by the IIS on the
same server. The voicemail service also uses the domain set to filter incoming SMTP mails received by the
SMTP server. For this to work, the domain entered should be the fully qualified name of the server on which
the voicemail server is running, for example vmpro1.example.com. Any incoming messages where the
recipient mail domain is not exactly the same as the specified domain are ignored. The recipient can either
by vmsyncmaster, vmsyncslave or the name or extension of a mailbox on the Voicemail Pro server, for
example Extn201@vmprocentral.example.com or 201@vmprocentral.example.com. 

· For subsequent entries: 
The domain specifies that these settings should be used for e-mails sent to the matching domain. The entry
must be a fully qualified name resolvable by DNS or an IP address.

· Server 
This specifies the IP address or fully qualified domain name of the SMTP server to which messages are sent. 

· For the first server entry in the list: 
Where messaging between voicemail servers is being used (central, backup and or distributed servers), the first
entry is used and will match the domain set above. 

· For subsequent entries: 
It will be the address of the e-mail server that will handle e-mails for recipients other than another voicemail server
on the network. 

· Port Number 
This is port to which messages are sent, usually 25.

· Sender (Identifier)
Note that some servers will only accept e-mails from a specific sender or sender domain. If left blank, the voicemail
server will insert a sender using either the e-mail address set for the voice mailbox user if set or otherwise using
the best matching name it can resolve from the IP Office. 

· Server Requires Authentication 
This check box indicates whether the connection to send SMTP messages to the mail server requires authentication
with that server. The authentication will typically be to the name and password of a mailbox account configured on
that server. 

· Account Name 
Sets the name to use for authentication.

· Password 
Set the password to use for authentication.

· User Challenge Response Authentication (Cram MD5) 
If this check box is selected, the name and password are sent using Cram MD5.

6.Click OK.

7.Click  Save and Make Live.
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3.3.2 MAPI Setup
3.3.2.1 Domain Member

Before you start to install the Voicemail Pro software, you must:

1. Create a Voicemail Domain Account .

2. Configure Outlook for Internet Mail .

 

You are then ready to install Voicemail Pro for MAPI Voicemail E-mail as a Domain Member. This involves the following
key stages:

1. Install the Voicemail Pro Software .

2. Install the MAPI Service .

3. Switch Voicemail Pro to MAPI .

 

3.3.2.1.1  Creating a Voicemail Domain Account

1. Make sure that the computer that is running the Voicemail MAPI service is a member of the domain. To join the
domain you will need access to a log account with administrative permissions on the domain as well as the server
computer, consult the domain administrator.

2. On the Exchange server:

· Create an account called Voicemail on the domain and an associated mailbox.

· Provide a secure password.

· Check the User Cannot Change Password and Password Never Expires boxes.

3. Log on to the voicemail server computer using a domain administrator account.

4. Click Start | Administrative Tools | Computer Management. 

5. In the left pane, expand Local Users and Groups, and click Groups.

6. Double-click Administrators, and click Add.

7. Click Locations and select the domain name in the list.

8. In the Enter the object names to select field, type Voicemail and click Check Names. 

9. Select Voicemail in the list and click OK followed by OK.
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Installation: Voicemail Email

3.3.2.1.2  Configuring Outlook for VoiceMail Email

To configure Outlook on your system, perform the following steps:

1. On the desktop, right-click the Outlook icon and select Properties.

2. On the General tab, select Add.

a. Select Microsoft Exchange Server.

b. Click Next.

c. In the Server field, enter the name of the Exchange server.

d. In the Mailbox field, enter Voicemail.

e. Click Next.

f. When you are asked if you travel with this computer, select No.

g. Click Next.

h. Click Finish.

3. Highlight the MS Exchange Settings and click Properties.

a. Highlight Microsoft Exchange Server and click Properties.

b. Click Check name.

c. If the name is resolved, select Apply.

d. Click OK, OK, and Close to shut the mail settings.

4. Do not continue until the name has been resolved correctly with the Exchange server. If the name is not resolved,
check the account details with the Exchange Administrator.

5. Open Outlook and select Yes to register Outlook as the default e-mail application.

a. Select Tools > Options.

b. Click the Preferences tab.

c. Click E-mail Options.

d. Uncheck Save copies of messages in Sent Items folder.

· You might want this option selected during initial setup to aid troubleshooting. However due to the size of wav
file message attachments you should uncheck it after installation testing is completed.

6. Log on to the computer running the Voicemail MAPI service using the voicemail account.

7. From Outlook, send a message direct to an extension user.

8. If this message is received correctly, you can continue installing the Voicemail Pro software. See Installing the
Voicemail Pro Software .

 

33



Implementing Voicemail Pro on Linux Page 28
15-601065 Issue 02b (Friday, April 06, 2012)IP Office 8.0

3.3.2.1.3  Installing the MAPI Service

You must install MAPI service on a Windows server to allow Voicemail Pro installed on Linux to communicate to MS
Exchange servers. 

Note: You must install MAPI on the same user's account on which you have installed Windows. Also note that if you are
running Exchange Server 2003, you must not install the MAPI Service on the same computer that runs the Exchange
server.

1.Insert the IP Office Applications DVD. Click on the link for Voicemail Pro MAPI and then double-click on setup.exe.

The system displays the Choose Setup Language menu. This language is used for the installation process and does not
affect the language prompts that are installed on the system.

2.Select the language for the installation process. 

3.Click OK.

The system displays the Preparing Installation menu.

· If the Modify, repair or remove the program window is displayed, follow the upgrade process.

The system displays the Welcome window. 

4.Click Next.

The system displays the License Agreement dialog box. 

5.Accept the terms and conditions and click Next.

The system displays the Customer Information menu.

· Use the default names or enter a user and company name. 

Note: These settings do not affect the Voicemail Pro MAPI installation. 

· Select the option Anyone who uses this computer (all users). 

· Enter the company name.

· Click Next.

The system displays the Choose Destination Location menu. 

6.Unless specifically required, for ease of maintenance, use the proposed folder location. Click Next.

7.The system displays the Service Account Name menu.

· Enter the user name and password of the account to use. Alternatively, click Browse and select a name from the
list of available computer or network accounts.

· Enter the port number that Voicemail Pro MAPI service will use.

· Click Next. The system validates the account name, password, and the port number. 

If the validation fails, the system prompts you to create a new account that matches the details entered. If the port
entered is already being used, the installer prompts you for entering a different port number. The system displays 
50792 as the default port number.

The system displays the Outlook Client Details dialog box. 

8.Enter a valid outlook profile and click Next.

The system displays the Ready to Install dialog box. 

9.Click Install.

The system prompts you to start the Voicemail Pro MAPI service. 

10.Click Yes to start the service immediately or click No to start the service later.

The system displays the Final Installation dialog box. 

11.Click Finish.

12.Switch Voicemail Pro to MAPI .29
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Installation: Voicemail Email

3.3.2.1.4  Adding Port to Windows Firewall

Voicemail Pro installed on Linux uses MAPI service as a proxy to the Microsoft Exchange server. Voicemail Pro will send
commands to the MAPI service, which in turn will send the corresponding MAPI commands to the Exchange server. The
responses from the Exchange server will be relayed back to the Voicemail Pro server via the MAPI service.

For the client servers to communicate with the Voicemail Pro server, add the port that the MAPI service uses to the
Windows Firewall.

1.Open the Windows Control Panel.

2.Open System and Security | Windows Firewall.

3.Click Advanced settings.

4.Click Inbound Rules in the left pane.

5.Click New Rule in the right pane.
The New Inbound Rule Wizard opens up.

6.Select Port and click Next.

7.Select TCP and enter the port number that the MAPI service uses in the Specific local ports field.

8.Click Next.

9.Select Allow the connection and click Next.

10.Check the Domain, Private, and Public check boxes.

11.Click Next.

12.Enter a name for the rule and click Finish.

13.Click Outbound Rules in the left pane and repeat step 5  to step 12 .

3.3.2.1.5  Switching VoiceMail Pro to MAPI

By default, the Voicemail Pro server is configured for SMTP e-mail mode. However, if MAPI settings are entered it will
switch to MAPI mode. Some options are not available if you are working offline. You must be working online to use this
feature. 

To select the server e-mail mode

1.Start the Voicemail Pro Client.

2.Click  Preferences and select General.

3.Click the Email tab.

4.Select the MAPI Service tab.

    a. In the Address field, type the IP address of the Windows based computer where the MAPI service is installed.

    b. In the Port field, type the default 50792 TCP Port of the Windows based computer where the MAPI service is
installed.

5. In the MAPI tab.

    a. Select Enable MAPI.

    b. Choose the MAPI e-mail account listed in Profile.

 6. Click OK.

      7. Click  Save and Make Live. 

29 29
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3.3.2.2 Work Group Member

Before you start to install the Voicemail Pro software, you must:

1. Create a Voicemail User Account .

2. Configure Outlook Express for Internet Mail .

3. Configure Outlook for Voicemail E-mail .

4. Configure Outlook for Exchange Server .

The user name and password created are requested as part of the installation of the Voicemail Pro service. The Microsoft
Outlook software must be installed on your computer before you can configure it.

You are then ready to install the Voicemail Pro software. See Installing the Voicemail Pro Software .

By default, Voicemail Pro is set to use SMTP for e-mails. Set Voicemail Pro to use MAPI. See Switching Voicemail Pro to
MAPI .

You also need to set the SMTP E-mail Account settings on the Voicemail Pro so that they match those of the customer's
e-mail server. See Changing SMTP E-mail Account Settings .

 

3.3.2.2.1  Installing VoiceMail Pro for MAPI VoiceMail Email as a Work Group Member

Before you start to install the Voicemail Pro software, you must:

1. Create a voicemail user account. See Creating a Voicemail User Account .

2. Configure Outlook Express for Internet Mail. See Configuring Outlook Express for Internet Mail .

3. Configure Outlook for Internet mail. See Configuring Outlook for Voicemail E-mail .

4. Configure Outlook for Exchange server. See Configuring Outlook for Exchange Server .

The user name and password created are requested as part of the installation of the Voicemail Pro service. The Microsoft
Outlook software must be installed on your computer before you can configure it.

You are then ready to install the Voicemail Pro software. See Installing the Voicemail Pro Software .

By default, Voicemail Pro is set to use SMTP for e-mails. Set Voicemail Pro to use MAPI. See , Switching Voicemail Pro to
MAPI .

You also need to set the SMTP E-mail Account settings on the Voicemail Pro so that they match those of the customer's
e-mail server. See  Changing SMTP E-mail Account Settings .

 

3.3.2.2.2  Creating a Voicemail User Account

To create a Voicemail User Account

For this example the name of the created user account is Voicemail.

1. Log on to the server computer using an administrator account.

2. Open the Windows Control Panel.

3. Click User Accounts | Add or remove user accounts.

4. Click Create a new account.

5. Enter Voicemail as the new account name and select Administrator as the account type.

6. Click Create Account.
The new account Voicemail is created and added to the list of user accounts.

7. Click Voicemail and create a secure password for the account.

8. Continue with one of the following as appropriate to the installed MAPI client and method for sending e-mail.
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3.3.2.2.3  Configuring Outlook Express for Internet Mail

To configure Outlook Express for Internet Mail

1. Click the Outlook Express icon to start the Configuration wizard.

2. In the Display name box enter Voicemail.

3. Click Next.

4. Select I already have an e-mail address that I'd like to use and enter the address in E-mail address, eg.
voicemail@example.com. Click Next.

5. Enter the name or address of the Incoming mail server and the Outgoing mail server. 
Note: If you enter the name, configure the IP address of the DNS Server in the voicemail computer.

6. Click Next.

7. Enter the e-mail account name and password, for example Voicemail. Select Remember password.

8. Click Next.

9. Click Finish to complete the wizard.

10.Open Outlook Express and select Tools > Options.

11.Click the General tab.

· Uncheck Send and Receive messages at Start up.

· Uncheck Check for new messages every.

12.Select the Send tab.

· Uncheck Save copy of sent messages in the 'Sent Items' folder.

· Check Send messages immediately.

· Under Mail Sending Format select Plain Text.

13.Click OK.

14.Log on to the server computer using the account that will be used for the Voicemail Pro server.

15.From Outlook or Outlook Express, send a message direct to an extension user.

16.If this message is received correctly, continue with installing the Voicemail Pro software.
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3.3.2.2.4  Configuring Outlook for Internet Mail

For the installation of Outlook to work correctly, the following setup process must be followed. Outlook can be configured
in two ways. Using the Wizard, prior to completing the steps below will cause Outlook not to send the messages
correctly.

To configure Outlook for Internet Mail:

1. Right-click the Outlook icon on the desktop and select Properties.

2. Select Add.

3. Select Internet E-mail and click OK.

4. For the Mail Account, enter Voicemail.

5. For User Information enter Voicemail as the Name and for the E-mail address enter your address, for example.
voicemail@example.com.

6. Select the Servers tab. Enter the name or IP address of the Outgoing mail server and Incoming mail server.

7. The Incoming Mail Server details can be left blank as Outlook does not need to check for mail. Otherwise, enter
the account name and password for example, Voicemail. Select Remember password.

8. Select the Connection tab. Select Connect using my local area network (LAN). Click Next.

9. Click OK.

10.Click Next.

11.Accept the default path for file creation.

12.Select Next, then Finish and then Close.

13.Open Outlook.

14.On the E-mail Service Option Screen, select Internet Only.

15.Click Next.

16.Select Yes to register Outlook as the default e-mail application.

17.Select Tools > Options.

18.Click the Preferences tab.

19.Click E-mail Options.

20.Uncheck Save copies of messages in Sent Items folder.

· You might want this option selected during initial setup and troubleshooting. Due to the size of wav file
message attachments it is advisable to uncheck it after installation is complete.

21.Log on to the server computer using the account that will be used for the Voicemail Pro server.

22.From Outlook or Outlook Express, send a message direct to an extension user.

23.If this message is received correctly, continue with installing the Voicemail Pro software.
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Installation: Voicemail Email

3.3.2.2.5  Configuring Outlook for Exchange Server

This option can be selected if Outlook is to be configured to connect to the Exchange server, using a valid user name and
password, while the Voicemail computer remains a member of a work group.

To configure Outlook for Exchange Server:

1. Create a new mailbox on the Exchange server, for example Voicemail, and assign it the same password as has
been configured on the voicemail computer.

2. Clear User must Change password at Next Logon and select Password Never Expires.

3. On the voicemail computer, logon with the Voicemail account.

4. Right-click the Outlook icon on the desktop and select Properties.

5. Select Add.

6. Highlight Microsoft Exchange Server and click OK.

7. Type in the Exchange server name and enter Voicemail in the Mailbox field.

8. Highlight the MS Exchange Settings, Click Properties.

9. Highlight Microsoft Exchange Server. Click Properties.

10.Click Check name.

11.If the name is resolved, select Apply. Click OK, OK and Close to shut the Mail settings.

12.Do not continue until the name has been resolved correctly with the Exchange server. If the name is not resolved,
check the account details with the Exchange administrator.

13.Open Outlook and select Yes to register Outlook as the default e-mail application.

14.Select Tools > Options.

15.Choose the Preferences tab. Click E-mail Options.

16.Uncheck Save copies of messages in Sent Items folder.

· You can keep this option selected during initial setup and troubleshooting. Due to the size of the wav file
message attachments, deselect it once the installation is complete.

17.Log on to the server computer using the account that will be used for the Voicemail Pro server.

18.From Outlook or Outlook Express, send a message direct to an extension user.

19.If this message is received correctly, continue with installing the Voicemail Pro software.

3.3.2.2.6  Installing the VoiceMail Pro Software

To install Voicemail Pro software, perform the following steps:

1. Log off and log on using the Voicemail account and password.

2. Install the required Voicemail Pro software. 

3. When the system prompts for a User Name and Password for the Voicemail Pro service, enter the Voicemail account
details.

4. Restart the server and log on using the Voicemail account.

5. When SMTP e-mail details are requested, enter no values and ignore the error message following the SMTP check.

6. Start the Voicemail Pro Service .

7. Check that the basic voicemail services start and operate correctly.

3.3.2.2.7  Switching VoiceMail Pro to MAPI

By default, the Voicemail Pro server is configured for SMTP e-mail mode. However, if MAPI settings are entered it will
switch to MAPI mode. Some options are not available if you are working offline. You must be working online to use this
feature. 

To select the server e-mail mode

1.Start the Voicemail Pro Client.

2.Click  Preferences and select General.

3.Click the Email tab.

4.Select the MAPI Service tab.

    a. In the Address field, type the IP address of the Windows based computer where the MAPI service is installed.

    b. In the Port field, type the default 50792 TCP Port of the Windows based computer where the MAPI service is
installed.

5. In the MAPI tab.

    a. Select Enable MAPI.

    b. Choose the MAPI e-mail account listed in Profile.

 6. Click OK.
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      7. Click  Save and Make Live. 
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3.3.2.2.8  Changing SMTP Email Account Settings

To change SMTP E-mail Account Settings:

1. Open the Windows Control Panel.

2. Select  IP Office Voicemail Pro.

3. Select the SMTP E-mail Settings tab. 

4. Enter the settings to match the customer's e-mail server and the e-mail account configured on that server for the
Voicemail Pro service.

5. Click the E-mail Settings tab. 

6. Enter the e-mail address for the account setup on the customer's e-mail server for the Voicemail Pro service.

7. Click Check to test the connection to the specified e-mail account.

8. Click OK. 
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3.3.3 Voicemail Email Operation
3.3.3.1 User and Group Configuration

The e-mail address for each user and hunt group is set through the IP Office configuration.

· Voicemail E-mail: Default = Blank (No voicemail e-mail features) 
This field is used to set the user or group e-mail address used by the voicemail server for voicemail e-mail
operation. When an address is entered, the additional Voicemail E-mail control below are selectable to configure
the type of voicemail e-mail service that should be provided. 

· Use of voicemail e-mail requires the voicemail pro server to have been configured to use either a local MAPI
e-mail client or an SMTP e-mail server account. See Voicemail E-mail Installation . 

· Use of voicemail e-mail for sending (automatic or manual) e-mail messages with wav files attached requires
discretion, as a one-minute message creates a wav file of 1MB size. 

· Voicemail E-mail Default = Off
If an e-mail address is entered for the user or group, the following options become selectable. These control the
mode of automatic voicemail e-mail operation provided by the voicemail server whenever the voicemail mailbox
receives a new voicemail message. 

· Users can change their voicemail e-mail mode using visual voice. If the voicemail server is set to IP
Office mode, user can also change their voicemail e-mail mode through the telephone prompts. The
ability to change the voicemail e-mail mode can also be provided in a call flow using a Personal
Options Menu action or a Generic action. 

· If the voicemail server is set to IP Office mode, users can manually forward a message to e-mail. 

· Off
If off, none of the options below are used for automatic voicemail e-mail. Users can also select this mode by
dialing *03 from their extension. 

· Copy
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a copy of
the message is attached to an e-mail and sent to the e-mail address. There is no mailbox synchronization
between the e-mail and voicemail mailboxes. For example reading and deletion of the e-mail message does
not affect the message in the voicemail mailbox or the message waiting indication provided for that new
message. 

· Forward
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, that
message is attached to an e-mail and sent to the e-mail address. No copy of the voicemail message is
retained in the voicemail mailbox and their is no message waiting indication. As with Copy, their is no
mailbox synchronization between the e-mail and voicemail mailboxes. Users can also select this mode by
dialing *01 from their extension. 
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· UMS Exchange
Voicemail Pro 5.0+ supports voicemail e-mail to an Exchange server e-mail account. For users and
groups also enabled for UMS Web Services this significantly changes their mailbox operation. The
Exchange server inbox is used as their voicemail message store and features such as message waiting
indication are set by new messages in that location rather than the voicemail mailbox on the voicemail
server. Telephone access to voicemail messages, including Visual Voice access, is redirected to the
Exchange server mailbox. See UMS Exchange Server Installation and UMS Exchange. 

· Alert
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a simple
e-mail message is sent to the e-mail address. This is an e-mail message announcing details of the voicemail
message but with no copy of the voicemail message attached. Users can also select this mode by dialing 
*02 from their extension. 

3.3.3.2 How Voicemail Email Messages Look

Messages sent by a user or group's voicemail e-mail settings contain the following:

· To 
The user/group e-mail address.

· From 
The name and address setting of the e-mail client account.

· Subject 
Voicemail Message ('calling number' > 'user name') From:'calling number'.

· Body 
If the user or group's Voicemail E-mail mode is set to Copy or Forward, the message body will contain "IP Office

Voicemail redirected message".

· Attachment 
When using Copy or Forward mode, the message is attached as a wav file.

 

Messages sent through a Voicemail Pro eMail action are configurable, see The Voicemail Pro eMail Action .
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3.3.3.3 The Voicemail Pro Email Action

The  eMail action in Voicemail Pro can be used to send messages through e-mail in response to caller actions in the
voicemail call flow. The action can also attach a wav file.

In the example above, the eMail action follows a Voice Question action. The $ in the eMail action's Attach file to e-
mail field instructs it to use the file recorded by the preceding Voice Question action.

The same method can be used with a Leave Mail action. Note however that the Leave Mail action must be set to a valid
target mailbox which will then have a copy of the message.

Alternatively, the eMail action can attach a prerecorded wav file by specifying the file name. That named file can be
created by an Edit Play List action.
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3.4 Text To Speech (TTS) Installation
The Voicemail Pro server uses Text To Speech (TTS) in the following ways:

· Speak text in call flows using the  Speak Text action. The text can include variables passed from other actions
including database actions. 

· When installed in parallel with Voicemail E-mail , TTS can be used to provide email reading  to selected mailbox
users.

· TTS can be used by the Voicemail Pro client user to record prompts used by call flow actions. 

Linux TTS Licensing
All TTS features (E-mail Reading, Speak Text Action, and Prompt Recording) require the VMPro TTS Professional license
before they can be used.
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Generic TTS Licensing
 Voicemail Pro Generic TTS is not supported on Linux.

Languages
 For Voicemail Pro 8.0 or higher on Linux, the TTS engine supports the same set of languages as Voicemail Pro speech
prompts except for Hungarian, Korean, and Chinese (Cantonese). For these unsupported languages, there will be no
alternate languages selected. If any of the three unsupported languages is configured in Voicemail Pro 8.0 or higher, then
TTS will not play anything.

Note: If you are using Voicemail Pro installed on Unified Communications Module, see Languages Supported on UC
Module Voicemail Pro . 

If more than one TTS language is installed, use Select System Prompt Language action to switch TTS to a different
language from the selected default. 

3.4.1 Installing Avaya Text to Speech
The TTS engine is packaged as a default component in the Voicemail Pro installation. However, you have to install the
languages separately, as no language is installed by default.  

To install Avaya Text To Speech on Linux: 

1.Install and test Voicemail Pro as normal.

2.Using IP Office Manager, add the VMPro TTS Professional license into the IP Office configuration. Send the new
configuration to the IP Office system. 

3.Reload the IP Office configuration into IP Office Manager and check that the status of the license has changed to
Valid.

3.4.2 Installing TTS Language Packs
To support languages other than the system defaults, install TTS Language Packs. Proceed as follows to install TTS
Language Packs:

1.During the installation of IP Office Application Server, select TTS Language Packs on the Package Selection screen.

2.When the installation process prompts you, insert one of the TTS Language Pack DVDs.
The list of languages on the DVD will be displayed.

3.Select the languages that you want to install, and select Next. 
After the selected languages are installed, you will be prompted to install more languages. 

4.Select OK and repeat step 2  to step 3  for each of the TTS Language Pack DVDs that you have. 
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5.Select Cancel to complete the installation.

Note: If you choose to install TTS Language Packs at a stage later than the installation of IP Office Application Server,
refer to the "Upgrading Applications" section of Avaya IP Office Application Server Installation and Maintenance (15-
160611).

3.4.3 Setting Up Text To Speech to Read Email

In conjunction with MAPI e-mail clients and Exchange server, TTS can be used to read new e-mails in a user's e-mail
inbox when they access their voicemail mailbox. 

· The Voicemail Pro server must have been installed and configure to support voicemail e-mail using a MAPI client
. 

· E-mail reading can only be enabled for IP Office users whose Profile setting is set to Mobile User or Power User.
That requires the IP Office to have Mobile User Profile or Power User Profile licenses. 

· This feature is supported only for Intuity mode. Users hear their new voicemail messages and then the number of
"Messages with text". Before each e-mail is spoken, details of who it is from, when the message was sent and the
size are given. These details assist you in deciding to skip large or non-urgent e-mails.

· E-mail reading cannot be used for e-mails in HTML format. If HTML messages are received, all of the code will be
read out as a message.

1.Within the IP Office configuration, display the settings for the user. 

2.On the User tab, set the user's Profile to either Mobile User or Power User. 

3.On the Voicemail tab: 

· Voicemail E-mail 
Enter the user's e-mail address. 

· Voicemail E-mail Reading 
Enable this option for TTS e-mail reading. 

Note: As Voicemail Pro Generic TTS is not supported on Linux, the e-mail reading feature is not available with the VMPro
Preferred and VMPro Advanced Editions licenses. You require the VMPro TTS Professional license to be able to use the
e-mail reading feature.
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3.5 Troubleshooting
3.5.1 Checking the Voicemail Pro Service

The IP Office application services installed on the IP Office Application Server can be started and stopped individually.
This is required for maintenance or if a particular service is not currently needed, for example, if one-X Portal for IP
Office has been installed but is not currently licensed.

The services can be set to automatically start after a server reboot. By default, all the IP Office services are automatically

started.

Starting a Service
1. Log in to the IP Office Application Server Web configuration pages.

2. Select Home (this is selected by default after logging in). The services and their current status (running or stopped)
are listed.

3. To start a particular service click on the Start button next to the service. To start all the services that are not

currently running, click on the Start All button.

For more information on starting and stopping Application Services see, IP Office Application Server documentation. 

3.5.2 Voicemail Pro User Log
For information on viewing user logs, see IP Office Application Server documentation.

Note: If you are using Voicemail Pro installed on Unified Communications Module, see Default Logging Level on UC
Module Voicemail Pro .

3.5.3 Assigning Permission to Users for MAPI
Use the steps in this section to assign permissions to user accounts to run the MAPI service. To assign permissions,
complete the following procedures:

1.Assign Send As permissions .

2.Assign additional permissions .

Assigning additional permissions
Procedures for assigning permissions are different for the different versions of Exchange Server. Select the procedure
that applies to your environment.

· Assigning permissions with Exchange 2003

· Assigning permissions with Exchange 2007

· Assigning permissions with Exchange 2010

3.5.3.1 Assigning Send As Permissions

To assign security permissions to the user under whose account MAPI service is to be executed:

1. Log on to the Active Directory server using an account that has Domain Administrator privileges.

2. Click Start | Administrative Tools | Active Directory Users and Computers.

3.  From the View drop-down menu, select Advanced Features.

4.  In the left pane of the Active Directory Users and Computers dialog box, right-click the domain and select
Properties.

5.  In the Properties dialog box, select the Security tab.

6. Click Advanced.

7.  In the Advanced Security Settings dialog box, click Add.

8.  In the Select Users, Computers, Service Account, or Group dialog box, add the user’s account. 

9.  Click OK.

10. In the Apply to field, select Descendant User objects.

11. In the Permissions box, select Send As permissions.

12. Click OK to close the Permission Entry dialog box.

13. Click OK to close the Advanced Security Settings dialog box.

14. Click OK to close the Properties dialog box.

The system periodically applies a security descriptor to the following groups, which results in the Send As permissions
being removed from these groups.
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· Administrators

· Domain Administrators

To prevent the Send As permissions from being removed:

1. Click Start > Run, type cmd, and click OK.
Note: You must be a member of the domain administrator group.

2. In the command window, enter the following:

dsacls "cn=adminsdholder,cn=system,dc=<xxx>,dc=<yyy>" /G "\<MM Security Group>:CA;Send As"

where,

· dc=<xxx>,dc=<yyy> is the customer’s fully qualified domain name (for example, dc=Avaya,dc=com). 

· <MAPI> is the name of the service permissions group.

It will take at least an hour for the security permissions to replicate to the user’s account.

3.5.3.2 Assigning Permissions with Exchange 2003

If the user is on Exchange 2003 server, proceed as follows:

1.Modify the advanced security settings for Mailbox Store.

2.Edit the registry to display the Security tab. 
Note: To edit the registry, you must be a member of the domain administrator group.

3.Add the additional permissions to the user account.

Modifying Advanced Security Settings for Mailbox Store

1.Log on to the Active Directory server using an account that has privileges to edit permissions (such as administrator).

2.Click Start | All Programs | Microsoft Exchange | System Manager.

3.In the left pane of the Exchange System Manager window, expand the Servers node in the tree.

4.Expand the server node in the list, and then expand the First Storage Group node.

5.Right-click Mailbox Store and select Properties.

6.In the Security tab of the Properties dialog box, click Advanced.

7.Under the Permissions tab of the Advanced Security Settings window, change all the Permission Entries to
Allow.

8.Restart the computer.

Editing the registry

If you are using Exchange System Manager or Active Directory Sites and Services, the Security tab for the Exchange
organization container and a few sub-containers are not visible. To enable the Security tab at all levels within the
Microsoft Exchange container, you can update the registry.

1. Log on as the Microsoft Exchange administrator.

2. Click Start > Run.

3.  In the Run dialog box, in the Open field, type regedit.

4.  Press Enter.

5.  In the Registry Editor dialog box, locate the following key:
“HKEY_CURRENT_USER\Software\Microsoft\Exchange\ExAdmin”

6. Right-click ExAdmin and select New > DWORD Value.

7.  Enter the following value name: ShowSecurityPage.

8.  Double-click the ShowSecurityPage value.

9. In the Edit DWORD Value dialog box, set the Value data to 1.

10. Click OK.

Adding permissions with Exchange 2003

Proceed as follows to add the additional permissions to the user’s account:

1.Log on to the Active Directory server using an account that has privileges to assign permissions to accounts (such as
administrator).

2.Click Start | Administrative Tools | Active Directory Sites and Services.
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3.In the left pane, select Active Directory Sites and Services.

4.From the View drop-down menu, select Show Services Node.

5.In the left pane, expand Services, expand Microsoft Exchange, and then locate the appropriate Exchange
Organization object that MAPI will connect to.

6.Right-click and select Properties.

7.In the Properties dialog box, click the Security tab. 
Note: This tab is visible only if you have edited the registry (see Editing the registry ).

8.Click Add.

9.In the Select Users, Computers, Service Accounts, or Groups dialog box, add the user’s account.

10.Click OK.

11.Under Permissions, select the permissions that you want to assign to the user's account. 

· Read

· Execute

· Read permissions

· Create children

· List contents

· Read properties

· Write properties

· Administer information store

· Create named properties in the information store

· View information store status

· Receive As

· Send As

12.Click Apply.

13.Click OK. 

14.Close the Active Directory Sites and Services dialog box.

15.Wait for the directory cache to expire.

3.5.3.3 Assigning Permissions with Exchange 2007

If user account is on Exchange 2007 server, proceed as follows to assign additional permissions to the user account:

1. Verify that the user to be added is a member of the Exchange recipient Administrator group.

2. Log on to the Active Directory server using an account that has privileges to assign permissions to accounts (such as
administrator).

3. Click Start | Administrative Tools | Active Directory Sites and Services.

4.  In the left pane, select Active Directory Sites and Services.

5.  From the View pull-down menu, select Show Services Node.

6.  In the left pane, expand Services, expand Microsoft Exchange, and then locate the appropriate Exchange
Organization.

7. Right-click it and select Properties.

8.  In the Properties window, click the Security tab.
The Security tab may not be visible in an environment with both Exchange 2003 and Exchange 2007 mail servers. To
enable the Security tab, see Editing the registry . 

9.  Click Add.

10. In the Select Users, Computers, Service Accounts, or Groups window, add the user’s account. 

11. Click OK.

12. Under Permissions for the group, select Read and click Apply.

13. Click Advanced.

14. In the Advanced Security Settings window, on the Permissions tab, select the check box at the bottom of the
window. This will apply the permissions inherited from the parent to this object and its child objects.

15. Click Add and add the user’s account.

16. Click OK.

17. In the Apply to field, select This object and all descendant objects.
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18. Verify that the following box is not selected: Apply these permissions to objects and/or containers within
this container only.

19. In the Permissions field, select the required permissions. 

· List contents

· Read all properties

· Write all properties

· Read permissions

· Create all child objects

· Administer information store

· Create named properties in the information store

· Receive As

· Send As

· View information store status

For a mixed environment of Exchange 2003 and Exchange 2007 mail servers, also select the following permissions, which
are only displayed for Exchange 2007 in the mixed environment:

· Read

· Execute

20. Click OK.

3.5.3.4 Assigning Permissions with Exchange 2010

If user account is on Exchange 2010 server, proceed as follows to assign additional permissions to the user account:

1. Verify that the user to be added is a member of the Exchange recipient Administrator group.

2. Log on to the Active Directory server using an account that has privileges to assign permissions to accounts (such as
administrator).

3. Click Start | Administrative Tools | Active Directory Sites and Services.

4.  In the left pane, select Active Directory Sites and Services.

5.  From the View pull-down menu, select Show Services Node.

6.  In the left pane, expand Services, expand Microsoft Exchange, right-click the appropriate Exchange Organization,
and select Properties.

7.  In the Properties window, click the Security tab.
The Security tab may not be visible in an environment with both Exchange 2003 and Exchange 2010 mail servers. To
enable the Security tab, see Editing the registry .

8. Click Add.

9.  In the Select Users, Computers, Service Accounts, or Groups window, add the user’s account. 

10. Click OK.

11. Under Permissions for the group, select Read and click Apply.

12. Click Advanced.

13. In the Advanced Security Settings window, on the Permissions tab, select the check box at the bottom of the
window. This will apply the permissions inherited from the parent to this object and its child objects.

14. Click Add and add the user’s account.

15. Click OK.

16. In the Apply to field, select This object and all descendant objects.

17. Verify that the following box is not selected: Apply these permissions to objects and/or containers within this
container only.

18. In the Permissions field, select the required permissions. 

· List contents

· Read all properties

· Write all properties

· Read permissions

· Create all child objects

· Administer information store

· Create named properties in the information store
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· Receive As

· Send As

· View information store status

For a mixed environment of Exchange 2003 and Exchange 2010 mail servers, also select the following permissions, which
are only displayed for Exchange 2010 in the mixed environment:

· Read

· Execute

19. Click OK.
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4. Using the Voicemail Pro Client
The Voicemail Pro client is used to administer the Voicemail Pro server. This section covers the basic operation of the
Voicemail Pro client to connect to a Voicemail Pro server. For details on administration using the Voicemail Pro client, see 
Avaya IP Office Administering Voicemail Pro (15-601063). 

For a Linux based server, the client must be installed on a separate Windows computer and then be used to administer
the server remotely. 

4.1 Logging in to the Voicemail Pro Server
If you start the Voicemail Pro client on the same computer as the voicemail server, the system will automatically load the
settings to manage the server. You will have full access to all the servers settings, you do not need to login with an
administrator account name and password. 

To connect to a remote voicemail server you will need to login using the name and password of an administrator account
already configured on that server. The default account is Administrator and Administrator. After logging in with this
account you should change the password from that default value. 

To Start the Voicemail Pro Client
1.From the Start menu, select Programs | IP Office | Voicemail Pro Client. 

2.The Voicemail Pro Client window opens. 

· If the client has been started before, it will start in the same mode as it used previously. If it fails to do that or
if it is the first time that the client has been started, the select mode menu is displayed. 

· Select either of the Offline modes to import and export voicemail call flow and module files without being
connected to any voicemail server. In the option Offline mode for Linux, those call flow options not supported
by a Linux base voicemail server are grayed out. 

· To connect to a voicemail server select Online. 

· Enter the name and password for an administrator account on the voicemail server. 

· Note that these are not required is accessing a voicemail server on the same computer as the client. 

· The default account is Administrator and Administrator. After logging in with this account you should
change the password from that default value.

· If three consecutive login attempts fail for an administrator account name, the account is locked for an
hour. 

· In the Unit Name\IP Address field enter the DNS name or IP address of the voicemail server. 
Note: If you are connecting to Voicemail Pro server installed on Unified Communications Module, see
Accessing UC Module Voicemail Pro .16
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· Alternatively click Browse to search the local network for a server and select a server from the results. 

Note: As Voicemail Pro client cannot find Voicemail Pro server running on Unified Communications Module,
you cannot use Browse to connect to Voicemail Pro server installed on Unified Communications Module.

3.If connected to a remote server, the Confirm Callflow Download window will be displayed. If you select
Download, any existing call flow that you have loaded in the client will be overwritten. For more details see Callflow
Download . 

4.If this is the first time that the voicemail server has been logged into, you should first change the default remote
access account. 

· If you logged in remotely using the default account, select File | Change Password. 

· If you logged in locally, select Voicemail Pro Administrators in the navigation panel.
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4.2 Confirm Call Flow Download Window
When you connect to a server across a LAN or WAN to view or modify the call flow on the server, a check is made to see
if the call flow that is stored locally on the client is the same. The call flow on the server might be different to the call flow
on the client because:

· The local call flow is older than the version on the server, for example if the call flow on the server has been
modified by another Client connection.

· The local call flow is newer than the version on the server, for example if the call flow on the server has been
worked on while the local Client was being used in offline mode.

· The local call flow is from a different server, for example if you are connecting to a different server to the one from
which the call flow was previously downloaded.

If the call flow is the same, no data will need to be copied from the server to the client. If the call flow is different you
can chose to download the call flow from the server or to use the local call flow.

· Download 
Click to download the call flow from the server.

· Cancel 
Click this if you do not want to download the call flow from the server.

To upload the local call flow to the server, use the Save or Save and Make Live options from the File menu. See
Saving Changes and Making them Live .

4.3 Continue Offline Message Window
Only one Voicemail Pro client can be connected to a voicemail server at any time. To prevent an idle client session from
blocking the server, a Client/Server Connection Timeout (mins)  setting is used to disconnect the idle client session. By
default, the timeout is set to 5 minutes. 

If your Voicemail Pro client session has timed out, the Voicemail Pro client will prompt you whether to re-establish the
session or close. You are then able to continue working in offline mode or to close the client. 
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4.4 Saving Changes and Making them Live
The call flow settings shown and edited using the Voicemail Pro client are stored in a database file (Vmdata.mdb) on the
voicemail server. However, when edited, the changes are not automatically applied to the operation of the voicemail
server. Instead the database file must be converted to a separate file (Root.vmp), that being the file that is used by the
voicemail server for its current operation. 

To Save the Configuration and Make It Live

1.Choose  Save & Make Live to save the settings as the Root.vmp file used by the voicemail server. 

· If you are working remotely in Offline mode, you will be prompted to select whether to save your changes to
the local database or to the remote server. 

To Save the Configuration to a File Without Making It Live
Call flow settings can be saved to a .vmp file and then included in the operation of another voicemail system. 

1.Choose  Save as to save the database as a .vmp file with the name that you specify. You can then copy the file
to other systems.

4.5 Logging Out
It can be useful to connect to a system to download the current system configuration and then disconnect and make
changes offline. You can then test configuration changes offline before applying them to a live system.

· Logging out is not the same as closing down with the Exit option. See Closing Down .

· If the Client and Server are installed on the same computer, the Log Out option is not available.

To Log Out
1.From the File menu, select Log Out. 

2.You are logged out of the Voicemail Pro server and placed in offline mode. You can either make configuration
changes offline and then log back in when you are ready or log on to a different server to work. See Logging in to
the Voicemail Pro Server .

4.6 Closing Down
When you have finished working, you can close down the Voicemail Pro Client. 

To Close the Voicemail Pro Client
1.From the File menu, select Exit.

2.If you have not made any changes, the Voicemail Pro Client closes and you are returned to the desktop. If you
have made any changes, you are prompted whether to save the changes.

3.If you do not want to save the changes, click No. No changes are saved. If you want to save the changes, click Yes
. The changes are saved but not made live.

4.If you want to make the changes live, click Save & make Live. 
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5. IP Office Configuration
The default IP Office configuration settings support almost immediate voicemail operation as soon as a voicemail server is
running on the LAN. Those default settings are:

· Voicemail running on a computer accessible by the IP Office using a broadcast address of 255.255.255.255.

· Voicemail on for each user and hunt group on.

· No Voicemail Code set for any mailboxes. Until a code is entered for a mailbox, it can only be accessed from the
user's own extension.

· No Voicemail E-mail or Voicemail Help operation.

· No Voicemail Reception numbers set for user mailboxes.

· Hunt group mailboxes are created and used by default but there is no default message waiting indication or method
for collecting messages. A method for accessing each hunt group mailbox should be programmed. 
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IP Office Configuration:  

5.1 User and Group Mailboxes
The voicemail server creates mailboxes based on the user and hunt group names that are entered in the IP Office
Manager application. Whenever the Voicemail Pro is restarted or the IP Office configuration is changed, new mailboxes
are created for any new names that are found.

This method of operation has the following consequences:

· Mailboxes are based on names 
For all users and groups, if their name is changed or deleted, they are no longer associated with their former
mailbox and any associated Voicemail Pro start points.

· Voicemail is case sensitive 
If a mailbox or start point name is entered incorrectly in IP Office Manager or Voicemail Pro, the intended operation
will not occur and the call may be disconnected.

· Voicemail removes spaces at the end of mailbox names 
If spaces are left at the end of a mailbox user's name in IP Office Manager, when the mailboxes are created, the
space at the end of the name is dropped. When this occurs the mailbox cannot be found as there is a mismatch
between the user name and directory. 
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5.2 System Settings
The IP Office can work with several different types of voicemail server. Therefore it is important to check that it is
configured for operation with Voicemail Pro. 

1.In IP Office Manager, select System.

2.Click the Voicemail tab. 

· Voicemail Type 
Specifies the type of voicemail system the IP Office is configured to work with. Unless detailed otherwise, the
option Voicemail Lite/Pro should be used with Voicemail Pro server. Additional options are displayed
depending on the selected voicemail type. 

· Centralized Voicemail  
This setting is used for remote systems in a Small Community Network where the central voicemail server is
being hosted by another IP Office. The Voicemail Destination field below is used to enter the Outgoing
Group ID of the SCN trunk to the IP Office hosting the central voicemail server. 

· Distributed Voicemail  (Software level = IP Office Release 6)
This option is used in a Small Community Network for remote IP Offices that you want to be associated with
their own voicemail servers in addition to the central voicemail server. The IP Office will require licenses for
Voicemail Pro operation and for the voicemail features required. The Voicemail IP Address below is used
to enter the IP address of the IP Office's voicemail server while the Voicemail Destination field below is
still used to set location of the central voicemail server as for centralized voicemail. 

· Embedded Voicemail 
Not used with Voicemail Pro. 

· Group Voicemail 
Not used with Voicemail Pro. 

· Remote Audix Voicemail 
Not used with Voicemail Pro. 

· Voicemail Lite/Pro 
This is the normal setting used for Voicemail Pro. 

· Voicemail IP Address 
By default the IP Office connects to the Voicemail Pro server by using the address 255.255.255.255 to
broadcast for any server on the same LAN as itself. When it receives a response it will use that voicemail
server. However you can set this access to a specific address. Change the default address (255.255.255.255)
to the IP address of the computer on which the Voicemail Pro server is running. 
Note: If you are using Voicemail Pro installed on Unified Communications Module, see Voicemail IP Address on
UC Module Voicemail Pro .

· For configuration of IP Office systems using centralized Voicemail Pro in an IP Office Small Community
Network (SCN), see Centralized Voicemail Pro . 

· Message Button Go To Visual Voice 
Many Avaya telephones have a fixed button labeled MESSAGES which can be used by the telephone user to
access their mailbox. If this option is selected, then on telephones able to support Visual Voice, visual voice is
used when the button is pressed rather than the standard voice prompt interface. 

· Voicemail Channel Reservation 
For calls going to voicemail from the IP Office, the IP Office can restrict how many sessions of various types are
active at the same time. See Voicemail Channel Reservation . 
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· DTMF Breakout (IP Office 5.0)
Previous breakout numbers for a user mailbox were set through the user voicemail settings . IP Office 5.0+
supports system defaults to be set. These are then applied to all user mailboxes unless the users own settings
differ. 

· Reception / Breakout (DTMF 0) 
The number to which a caller is transferred if they press 0 while listening to the mailbox greeting rather
than leaving a message (*0 on embedded voicemail).

· For systems set to Intuity emulation mode, the mailbox user can also access this option when collecting
their messages by dialing *0. 

· If the mailbox has been reached through a call flow containing a Leave Mail action, the option provided
when 0 is pressed are: 

· For IP Office mode, the call follows the Leave Mail action's Failure or Success results connections
depending on whether the caller pressed 0 before or after the record tone.

· For Intuity mode, pressing 0 always follows the Reception / Breakout (DTMF 0) setting. 

· Breakout (DTMF 2) 
The number to which a caller is transferred if they press 2 while listening to the mailbox greeting rather
than leaving a message (*2 on embedded voicemail). For pre-5.0 systems this option is not support for
Voicemail Pro running in IP Office mailbox mode. 

· Breakout (DTMF 3) 
The number to which a caller is transferred if they press 3 while listening to the mailbox greeting rather
than leaving a message (*3 on embedded voicemail). For pre-5.0 systems this option is not support for
Voicemail Pro running in IP Office mailbox mode.

· SIP Settings 
These options are available when the IP Office configuration contains a SIP line or an H323 SCN line. The values
are used when the voicemail server makes calls using a SIP trunk or to a SIP device. 

· SIP Name: Default = User name. 
The value from this field is used when the From field of the SIP URI being used for a SIP call is set to Use
Internal Data.

· SIP Display Name (Alias): Default = User name. 
The value from this field is used when the Display Name field of the SIP URI being used for a SIP call is set
to Use Internal Data.

· Contact: Default = User name. 
The value from this field is used when the Contact field of the SIP URI being used for a SIP call is set to
Use Internal Data.

· Anonymous: Default = Off. 
If the From field in the SIP URI is set to Use Internal Data, selecting this option inserts Anonymous into
that field rather than the SIP Name set above.

3.Click OK to save any changes.

4.Send the configuration back to the IP Office. 
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5.3 User Voicemail Settings
Voicemail can be configured for each individual user in IP Office Manager. 

1.Open IP Office Manager.

2.In the Navigation pane, click  User and select the individual user.

3.Select the Voicemail tab. 

· Voicemail Code / Confirm Voicemail Code 
These fields are used to set or change the user's mailbox passcode. 

· If the voicemail server is set to Intuity Emulation mode, mailbox users are asked to set a voicemail code
the first time that they access the mailbox. 

· Voicemail On Default = On
When on, the mailbox is used by the IP Office to answer the user's unanswered calls or calls when the user's
extension returns busy. Note that selecting off does not disable use of the user's mailbox. Messages can still be
forward to their mailbox and recordings can be placed in it. The mailbox can also still be accessed to collect
messages. 

· Voicemail Help Default = Off
For voicemail systems running IP Office mailbox mode, this option controls whether users retrieving messages
are automatically given an additional prompt "For help at any time press 8." If switched off, users can still press
8 for help. For voicemail systems running in Intuity emulation mode, this option has no effect. On those
systems the default access greeting always includes the prompt "For help at any time, press *4" (*H in the US
locale).

· Voicemail Ringback Default = Off
When on, if the user has a new message, the voicemail server can call the user's extension whenever the
extension changes from off-hook to on-hook. The voicemail server will not ring the extension more than once
every 30 seconds. 

· Voicemail E-mail: Default = Blank (No voicemail e-mail features) 
This field is used to set the user or group e-mail address used by the voicemail server for voicemail e-mail
operation. When an address is entered, the additional Voicemail E-mail control below are selectable to configure
the type of voicemail e-mail service that should be provided. 

· Use of voicemail e-mail requires the voicemail pro server to have been configured to use either a local MAPI
e-mail client or an SMTP e-mail server account. See Voicemail E-mail Installation . 

· Use of voicemail e-mail for sending (automatic or manual) e-mail messages with wav files attached requires
discretion, as a one-minute message creates a wav file of 1MB size. 

· Voicemail E-mail Default = Off
If an e-mail address is entered for the user or group, the following options become selectable. These control the
mode of automatic voicemail e-mail operation provided by the voicemail server whenever the voicemail mailbox
receives a new voicemail message. 

· Users can change their voicemail e-mail mode using visual voice. If the voicemail server is set to IP
Office mode, user can also change their voicemail e-mail mode through the telephone prompts. The
ability to change the voicemail e-mail mode can also be provided in a call flow using a Personal
Options Menu action or a Generic action. 

· If the voicemail server is set to IP Office mode, users can manually forward a message to e-mail. 

· Off
If off, none of the options below are used for automatic voicemail e-mail. Users can also select this mode by
dialing *03 from their extension. 
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· Copy
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a copy of
the message is attached to an e-mail and sent to the e-mail address. There is no mailbox synchronization
between the e-mail and voicemail mailboxes. For example reading and deletion of the e-mail message does
not affect the message in the voicemail mailbox or the message waiting indication provided for that new
message. 

· Forward
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, that
message is attached to an e-mail and sent to the e-mail address. No copy of the voicemail message is
retained in the voicemail mailbox and their is no message waiting indication. As with Copy, their is no
mailbox synchronization between the e-mail and voicemail mailboxes. Users can also select this mode by
dialing *01 from their extension. 

· UMS Exchange
Voicemail Pro 5.0+ supports voicemail e-mail to an Exchange server e-mail account. For users and
groups also enabled for UMS Web Services this significantly changes their mailbox operation. The
Exchange server inbox is used as their voicemail message store and features such as message waiting
indication are set by new messages in that location rather than the voicemail mailbox on the voicemail
server. Telephone access to voicemail messages, including Visual Voice access, is redirected to the
Exchange server mailbox. See UMS Exchange Server Installation and UMS Exchange. 

· Alert
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a simple
e-mail message is sent to the e-mail address. This is an e-mail message announcing details of the voicemail
message but with no copy of the voicemail message attached. Users can also select this mode by dialing 
*02 from their extension. 

· UMS Web Services 
If selected, the user is able to use UMS to access their mailbox. Using the UMS options, messages can be
accessed via a web browser, an IMAP compatible e-mail application, or an Exchange server e-mail account. The
use this function is subject to licenses. 

· DTMF Breakout
When a caller is directed to voicemail to leave a message, they can be given the option to be transferred to a
different extension. The greeting message needs to be recorded telling the caller the options available. The
extension numbers that they can be transferred to are entered in the fields below. For IP Office 5.0+, these
system default values can be set for these numbers and are used unless a different number is set within these
user settings. 

· Reception / Breakout (DTMF 0) 
The number to which a caller is transferred if they press 0 while listening to the mailbox greeting rather
than leaving a message (*0 on embedded voicemail).

· For systems set to Intuity emulation mode, the mailbox user can also access this option when collecting
their messages by dialing *0. 

· If the mailbox has been reached through a call flow containing a Leave Mail action, the option provided
when 0 is pressed are: 

· For IP Office mode, the call follows the Leave Mail action's Failure or Success results connections
depending on whether the caller pressed 0 before or after the record tone.

· For Intuity mode, pressing 0 always follows the Reception / Breakout (DTMF 0) setting. 

· Breakout (DTMF 2) 
The number to which a caller is transferred if they press 2 while listening to the mailbox greeting rather
than leaving a message (*2 on embedded voicemail). For pre-5.0 systems this option is not support for
Voicemail Pro running in IP Office mailbox mode. 

· Breakout (DTMF 3) 
The number to which a caller is transferred if they press 3 while listening to the mailbox greeting rather
than leaving a message (*3 on embedded voicemail). For pre-5.0 systems this option is not support for
Voicemail Pro running in IP Office mailbox mode.

4.Click OK to save the voicemail changes for the user.

5.Amend any other user details, then save and merge the configuration changes.
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5.4 User Source Numbers
The Source numbers can be changed for individual users in IP Office Manager. The Source Numbers tab gives a list of
Dial In Source Numbers. Several of these numbers can relate to voicemail operation. The source number settings that
can be used for Voicemail Pro are:

· V<Caller's ICLID> = Voicemail Trusted Source Access. 
Strings prefixed with a v indicate numbers from which access to the user's mailbox does not require entry of the
mailbox's voicemail code.

· When in Intuity mode users will still have to enter their voicemail code if they use the Messages button on their
telephone. However, If they have a button programmed to collect voicemail they can access their mailbox
without entering their voicemail code.

· H<Group Name> = Hunt Group Voicemail Indication. 
Configures the user to receive message waiting indication for new group messages. Enter H followed by the group
name, for example HMain for the group Main. 

· P<Telephone Number> = Voicemail Ringback Number. 
This entry sets the destination for callback (outbound alert) calls from voicemail. Enter P followed by the telephone
number including any external dialing prefix, for example P917325559876. This facility is only available when
using Voicemail Pro through which a default Callback or a user specific Callback start point has been configured.
This feature is separate from voicemail ringback which alerts the user's own extension.

To add a source number:

1.Open IP Office Manager.

2.In the Navigation pane, click  User and select the individual user.

3.View the Source Numbers tab.

4.Click Add. 

5.Enter the number in the Source Number field at the bottom of the window.

6.Click OK and save the configuration file.
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5.5 Hunt Group Settings
Voicemail can be configured for each hunt group on the IP Office system. This section looks at the basic voicemail
settings.

Voicemail Answer Time
For IP Office 4.0+, the condition under which calls targeted to a hunt group go to voicemail has been changed to a
timeout. For calls waiting to be answered, once this timeout expires the call is redirected to voicemail regardless of where
it is in the hunt group. 

Hunt Group Settings
1.Open IP Office Manager.

2.In the Navigation pane, click  Hunt Group and select the hunt group.

3.Select the Voicemail tab.

· Voicemail Code / Confirm Voicemail Code 
Enter a voicemail code between 1-15 digits in the Voicemail Code field. This is required when users retrieve
voicemail messages for the hunt group remotely, for example from an extension that is not a member of the
hunt group or from an external telephone.

· Voicemail E-mail: Default = Blank (No voicemail e-mail features) 
This field is used to set the user or group e-mail address used by the voicemail server for voicemail e-mail
operation. When an address is entered, the additional Voicemail E-mail control below are selectable to configure
the type of voicemail e-mail service that should be provided. 

· Use of voicemail e-mail requires the voicemail pro server to have been configured to use either a local MAPI
e-mail client or an SMTP e-mail server account. See Voicemail E-mail Installation . 

· Use of voicemail e-mail for sending (automatic or manual) e-mail messages with wav files attached requires
discretion, as a one-minute message creates a wav file of 1MB size. 

· Voicemail E-mail Default = Off
If an e-mail address is entered for the user or group, the following options become selectable. These control the
mode of automatic voicemail e-mail operation provided by the voicemail server whenever the voicemail mailbox
receives a new voicemail message. 

· Users can change their voicemail e-mail mode using visual voice. If the voicemail server is set to IP
Office mode, user can also change their voicemail e-mail mode through the telephone prompts. The
ability to change the voicemail e-mail mode can also be provided in a call flow using a Personal
Options Menu action or a Generic action. 

· If the voicemail server is set to IP Office mode, users can manually forward a message to e-mail. 
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· Off
If off, none of the options below are used for automatic voicemail e-mail. Users can also select this mode by
dialing *03 from their extension. 

· Copy
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a copy of
the message is attached to an e-mail and sent to the e-mail address. There is no mailbox synchronization
between the e-mail and voicemail mailboxes. For example reading and deletion of the e-mail message does
not affect the message in the voicemail mailbox or the message waiting indication provided for that new
message. 

· Forward
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, that
message is attached to an e-mail and sent to the e-mail address. No copy of the voicemail message is
retained in the voicemail mailbox and their is no message waiting indication. As with Copy, their is no
mailbox synchronization between the e-mail and voicemail mailboxes. Users can also select this mode by
dialing *01 from their extension. 

· UMS Exchange
Voicemail Pro 5.0+ supports voicemail e-mail to an Exchange server e-mail account. For users and
groups also enabled for UMS Web Services this significantly changes their mailbox operation. The
Exchange server inbox is used as their voicemail message store and features such as message waiting
indication are set by new messages in that location rather than the voicemail mailbox on the voicemail
server. Telephone access to voicemail messages, including Visual Voice access, is redirected to the
Exchange server mailbox. See UMS Exchange Server Installation and UMS Exchange. 

· Alert
If this mode is selected, each time a new voicemail message is received in the voicemail mailbox, a simple
e-mail message is sent to the e-mail address. This is an e-mail message announcing details of the voicemail
message but with no copy of the voicemail message attached. Users can also select this mode by dialing 
*02 from their extension. 

· Voicemail On Default = On
When on, the mailbox is used by the IP Office to answer the user's unanswered calls or calls when the user's
extension returns busy. Note that selecting off does not disable use of the user's mailbox. Messages can still be
forward to their mailbox and recordings can be placed in it. The mailbox can also still be accessed to collect
messages. 

· Voicemail Help Default = Off
For voicemail systems running IP Office mailbox mode, this option controls whether users retrieving messages
are automatically given an additional prompt "For help at any time press 8." If switched off, users can still press
8 for help. For voicemail systems running in Intuity emulation mode, this option has no effect. On those
systems the default access greeting always includes the prompt "For help at any time, press *4" (*H in the US
locale).

· Broadcast 
Select the option Broadcast if you want any voicemail messages left for the hunt group to be forwarded to the
mailboxes of the individual group members. The original message in the hunt group mailbox is deleted after
being broadcast. 

· UMS Web Service (IP Office 5.0+)
If selected, the hunt group mailbox can be accessing using UMS via a web browser or an IMAP compatible e-
mail application. 

4.Click OK and save the configuration.
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5.6 Voicemail Channel Reservations
By default inbound calls routed from IP Office to voicemail are able to use any available voicemail channels, up to the
limit of the number of licensed channels , regardless of how many calls of the same type are already in progress.
However, if required, channels can be reserved for different types of inbound calls to the voicemail server. 

Voicemail channel reservations can be made for:

· Auto Attendant 

· Announcements 

· Voice recording 

· Mailbox access 

· Mandatory voice recording 

It is worth checking the voicemail channel reservations if there are problems. If insufficient voicemail channels are
available:

· Internal calls to an auto attendant are queued. The call will queue until a resource becomes available.

· Announcements are not heard by the caller, but the call is routed correctly.

· Manual voice recording is activated but no recording is made. The call will continue.

· Users are placed in a queue when trying to access their mailbox access.

· A user with mandatory recording on outgoing calls (internal and external) gets a busy tone.

· A call on a line with mandatory recording set will be barred.

To change voicemail channel reservations:

1.Open IP Office Manager and the load the configuration.

2.In the Navigation pane click  System and select the system.

3.Click the Voicemail tab. 

4.Amend the channel reservations as required. By default the values are 0. 
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To view the utilization of voicemail channels:

1.Open the System Status Application.

2.Click Resources. The System Resources summary is displayed. The following details are displayed:

· The number of voicemail channels available.

· The number of channels in use.

· Congestion information

Channel Restrictions

· The Voicemail Pro server has restrictions on the number of channels it can use for different types of outgoing calls
that it can make. These limits are separate for each of the call types. When a limit is reached, further calls of that
type are delayed until one of the existing calls is completed. These limitations are not controlled by Voicemail
Channel Reservation  settings. 

· Outcalling can use up to 5 channels at any time. 

· Conference center invitation calls can use up to 5 channels at any time. 

· Callback calls can use up to 2 channels at any time. 

· Alarm calls can use up to 2 channels at any time. 
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System Preferences

Chapter 6.
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6. System Preferences
A range of voicemail server settings can be set through the Voicemail Pro client. 

To change the Voicemail Pro Preferences
1.Click the Preferences  icon and then choose General or VPNM. Alternatively, from the Administration menu,

select Preferences and then choose General or VPNM.

2.Select the System Preferences tab required.

· General  
General voicemail server settings. 

· Directories  
Set the folder paths for different file locations. 

· Housekeeping  
Set the times for automatic deletion of different types of messages. Also set the default playback order. 

· E-mail  
Select the e-mail mode (MAPI or SMTP) used by the voicemail server for its e-mail functions and configure
various settings for the selected mode. 

· SNMP Alarm  
Set the criteria which will cause the voicemail server to send alarms via the IP Office. 

· Outcalling  
Set the default times for outcalling operation and the frequency of outcalling retires. 

· VPNM 
If VPNM is installed and licensed, this tab is available to set the locations of the remote VPNM servers and
the mailbox users on those servers. 
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System Preferences:  

6.1 General
Although the default IP Office configuration settings support voicemail to start operating almost immediately, as soon as
a voicemail server is running on the LAN, there are some general system preferences that you can set or change.

To set up general system preferences:

1.Display the main Voicemail Pro window.

2.From the Administration menu, select Preferences > General. 

· Debug Level: Default = Information
Set the level of information that the server should output for logging if required. 
Note: If you are using Voicemail Pro installed on Unified Communications Module, see Default Logging Level on UC
Module Voicemail Pro .

· Default Telephony Interface: Default = Intuity 
Select the mailbox operation mode for all mailboxes. The options are IP Office mode or Intuity emulation mode. 

· Voicemail Password: Default = Blank 
A voicemail password is optional for the voicemail server is optional. If you set a password here, it must match the
Voicemail Password configured within the IP Office's security settings. See Identifying the Voicemail Server
Computer . 

· Client/Server Connection Timeout (mins): Default =5 minutes. 
The voicemail server supports only one Voicemail Pro client to be connected at a time. This timeout logs out an
inactive client, stopping it from preventing another client from connecting. 

· Min. Message Length (secs): Default = 3 seconds. 
By default the minimum message length is 3 seconds in IP Office mailbox mode, 0 seconds in Intuity emulation
mode. Use this field to set the minimum length between 0 and 10 seconds. Messages under this length are deleted
immediately.

· Max. Message Length (secs): Default = 120 seconds. 
This value sets the maximum length for messages. The default message length is 120 seconds. The maximum
message length is 3600 seconds (60 minutes). 1 minute equals approximately 1MB of disk space.

· Max. Call\VRL Record Length (secs):  Default =3600 seconds. 
This value sets the maximum recording time for recorded calls. The default and maximum length is 3600 seconds
(60 minutes). 

· Play Advice on Call Recording: Default = On 
If selected, an advice warning is played whenever call recording is started advising the callers that their call is
being recorded. This may be a legal requirement in some countries and so should not be disabled without checking
first.

· System Fax Number: Default = Blank 
This field can be used to set the number of the fax machine to which all incoming faxes should be directed. If a fax
board is being used, this number must match the number of the extension that is connected to the fax board of the
fax server computer. 

· Intuity mailbox owners have the additional option to define their own personal fax number instead of the
system fax number. As the system administrator, you still need to set a system fax number to enable mailbox
owners to override it with their preferred personal fax number. Incoming calls are directed to Voicemail Pro and
then Voicemail Pro redirects fax calls to the mailbox owner's personal fax number, if one has been set. For
details, mailbox owners can refer Avaya IP Office Intuity Mailbox Mode User Guide (15-601130).

· If your fax system requires prefix addressing, for example the C3000 fax server, do not type a fax number in
the System Fax Number box. Instead type the number to use as a prefix so that a fax message can be
identified and forwarded to the extension number of the intended recipient. For example, if the prefix were 55,
a fax message for extension 201 would have the prefix of 55 automatically added so that the complete number
would become 55201.

· System Fax Number 
By default fax detection is not enabled when Voicemail Pro is first installed. When fax detection is enabled, any fax
calls that are left in a voicemail mailbox, are redirected to this system fax number.

· Use as a Prefix 
If your fax system does not use prefix addressing, leave this box unchecked. For this feature to work, you also
need to set up a short code. 

· Enable Fax Sub-Addressing 
Most fax servers perform fax forwarding based on DTMF signaling received with the fax call. Check the Enable
Fax Sub-Addressing box so that the DTMF signal is passed to the fax server after the call has been answered
so that the fax can be forwarded to the e-mail address of the intended recipient.

3.Click OK.

4.Click  Save and Make Live and select Yes.
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6.2 Directories
When Voicemail Pro is installed some default folder locations are used. You can change these if required.

To set the location of Voicemail system folders:

1.Display the main Voicemail Pro window.

2.From the Administration menu, select Preferences > General.

3.Click the Directories tab. 

· Voicemail Server Directory 
The path to the folder where the voicemail server program is to be stored. This is the folder where the file 
Root.vmp is saved when the Save & Make Live option is used.

· Voicemail Server Speech Directory 
The path to the folder where the libraries of speech prompts are to be stored. 

· Remote Campaign Directory 
The path to the folder where the campaign files are to be stored.

4.Click OK.

5.Click  Save and Make Live and select Yes.
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6.3 Email
The Email tab is used to configure which e-mail mode (MAPI or SMTP) the voicemail server should use and the settings
for that mode. 

6.3.1 MAPI
This form is used to configure MAPI settings for use by the voicemail server.

MAPI Service

Use this tab to configure the IP address and port of the MAPI proxy service.

· Address

This text box is used to enter the TCP address of the Windows-based computer where MAPI Service is installed.

· Port

This text box is used to enter the default 50792 TCP Port of the Windows-based computer where MAPI Service
is installed.



Implementing Voicemail Pro on Linux Page 70
15-601065 Issue 02b (Friday, April 06, 2012)IP Office 8.0

MAPI

· Enable MAPI 
Selecting this option will switch the voicemail server to using MAPI for its e-mail options rather than SMTP. 

· Profile 
This is used to select the MAPI e-mail account the voicemail server should use to provide visibility to the e-mail
account mailboxes for which it requires access. The profile must exist within the MAPI e-mail client on the
server computer and must be useable by the Windows account under which the Voicemail Pro service is
running.

6.3.2 SMTP Sender
These settings are used to configure the SMTP server and server account that the voicemail server uses for sending
e-mails using SMTP.

Multiple servers can be configured. The first entry specifies the default SMTP server used for sending e-mails if there is
no other entry matching the domain specified in the e-mail destination address. Additional servers can be added when
different settings are required for sending e-mails to specific domains. For example, the default can be configured for the
customer's internal network exchange server with additional entries added for e-mails to external e-mail domain
addresses such as yahoo.com.

· Messaging Between Voicemail Servers 
VPNM, distributed voicemail servers and primary/backup voicemail servers all use SMTP to exchange information
and messages between the voicemail servers. When that is the case the first entry in the SMTP Sender list must
be the one used and needs to be configured for that service with the domain and server setting both matching the
IP address or fully qualified domain of the voicemail server. 

In the example below, the first entry is being used for messages to other voicemail servers. Its own address is used as
both the domain and server settings as an SMTP service on the same server as the voicemail service is used (eg. IIS
SMTP on the Windows server). The next entry is used for other e-mails that use the customer's general e-mail domain
address with the server set to the customers e-mail server. A third entry has been added to send some e-mails
generated by E-mail Actions in call flows direct to an external e-mail service. 
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· The first two entries in the example above can be combined. Voicemail server to server synchronization uses the 
Domain setting only whereas other e-mail services use the Server address and other setting. 
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SMTP Sender Settings

· Logging 
If selected, SMTP logging  by the server is enabled. 

· Servers 
This section is used to enter details of the SMTP server or servers to which the voicemail server send its

messages. 
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To add a server, click on the . icon. To edit the server, click on the  icon. To delete a server entry, click on . 

· Mail Domain 
This field is used differently depending on whether it is the first entry in the list or not: 

· For the first server entry in the list: 
This is the default outgoing e-mail settings. It also sets the mail destination domain on which the voicemail
server filters incoming messages (see below) and so is repeated on the SMTP Receiver  tab. 

· Messaging Between Voicemail Servers 
For messaging between voicemail servers, the first entry in the SMTP Sender list must be the one
configured and used. Each server uses the SMTP server service on the same server computer as the
voicemail service. For example a Windows based servers uses the SMTP e-mail provided by the IIS on the
same server. The voicemail service also uses the domain set to filter incoming SMTP mails received by the
SMTP server. For this to work, the domain entered should be the fully qualified name of the server on which
the voicemail server is running, for example vmpro1.example.com. Any incoming messages where the
recipient mail domain is not exactly the same as the specified domain are ignored. The recipient can either
by vmsyncmaster, vmsyncslave or the name or extension of a mailbox on the Voicemail Pro server, for
example Extn201@vmprocentral.example.com or 201@vmprocentral.example.com. 

· For subsequent entries: 
The domain specifies that these settings should be used for e-mails sent to the matching domain. The entry
must be a fully qualified name resolvable by DNS or an IP address.

· Server 
This specifies the IP address or fully qualified domain name of the SMTP server to which messages are sent. 

· For the first server entry in the list: 
Where messaging between voicemail servers is being used (central, backup and or distributed servers), the first
entry is used and will match the domain set above. 

· For subsequent entries: 
It will be the address of the e-mail server that will handle e-mails for recipients other than another voicemail server
on the network. 

· Port Number 
This is port to which messages are sent, usually 25.

· Sender (Identifier)
Note that some servers will only accept e-mails from a specific sender or sender domain. If left blank, the voicemail
server will insert a sender using either the e-mail address set for the voice mailbox user if set or otherwise using
the best matching name it can resolve from the IP Office. 

· Server Requires Authentication 
This check box indicates whether the connection to send SMTP messages to the mail server requires authentication
with that server. The authentication will typically be to the name and password of a mailbox account configured on
that server. 

· Account Name 
Sets the name to use for authentication.

· Password 
Set the password to use for authentication.

· User Challenge Response Authentication (Cram MD5) 
If this check box is selected, the name and password are sent using Cram MD5.
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6.3.3 SMTP Receiver
This tab is used to set where the voicemail server checks for incoming SMTP messages. The SMTP Receiver setting can
be set to either Internal or External. 

· Internal  
Use this option for voicemail servers running on the IP Office Application Server server. 

· External  
Use this option when the voicemail server is on a server where is co-exists with a third-party SMTP application, for
example an IIS server with SMTP enabled.

Internal
The Internal setting can be used when the voicemail server should check the appropriate account on an SMTP server for
waiting messages. The server settings will be pre-populated using the entries from the SMTP Sender  form. 

· Distributed/Primary/Backup Voicemail
This is the option that should be used when the voicemail server is a IP Office Application Server (Linux) based
server in a network distributed voicemail servers are being used or is a server in a primary/backup voicemail
server pairing. 

 

· Port 
This is the port on which the Voicemail Pro server listens for incoming messages. The default is 25. 

· Domain 
This is the domain destination address for which the server will accept incoming e-mails. Note that it matches the
domain set by the first server entry in the SMTP Sender  tab. 

· Messaging Between Voicemail Servers 
For messaging between voicemail servers, the first entry in the SMTP Sender list must be the one
configured and used. Each server uses the SMTP server service on the same server computer as the
voicemail service. For example a Windows based servers uses the SMTP e-mail provided by the IIS on the
same server. The voicemail service also uses the domain set to filter incoming SMTP mails received by the
SMTP server. For this to work, the domain entered should be the fully qualified name of the server on which
the voicemail server is running, for example vmpro1.example.com. Any incoming messages where the
recipient mail domain is not exactly the same as the specified domain are ignored. The recipient can either
by vmsyncmaster, vmsyncslave or the name or extension of a mailbox on the Voicemail Pro server, for
example Extn201@vmprocentral.example.com or 201@vmprocentral.example.com. 

6.4 Housekeeping
This tab is used to set the Voicemail Pro server settings for automatically deleting messages and for the default playback
order of messages. For Voicemail Pro 6.0+ it is also used to access options for backing up and restoring voicemail
messages and settings. 

The voicemail servers housekeeping settings can be used to configure how long messages and recording are retained
before the server will automatically delete them. The playback order for different types of messages can also be set. Note
that the housekeeping deletion settings are not applicable for messages stored on the Exchange server. 
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1.From the Administration menu, select Preferences > General.

2.Click the Housekeeping tab. 

 

3.Delete after 
Sets the time, in hours, after which messages of various types automatically deleted. A value of 0 disables
automatic deletion. The actual deletion is performed during the next idle period during which there are no calls to or
from the voicemail server.

4.Playback Order 
Sets the order of playback used for different message types. The options are first in-first out (FIFO) and last in-
first out (LIFO). FIFO is the default. 

· The different message status types are: 

· New 
This status is applied to messages where neither the header or the message content has been played. 

· Old 
This status is applied to messages where the user has played the message content but has not marked the
message as saved. 

· Saved 
This status is applied to messages that have been marked as saved by the user. 

· Unopened 
This status is used for messages where, in Intuity emulation mode, the user has played the message header
but has not played the message content. 

· New Recordings 
This status is used for recordings that have not been played. 

· Old Recordings 
This status is used for recordings that have been played. 

· Deleted Messages 
This status is used for messages that have been marked as deleted through mailbox access. 

5.Click OK.

6.Click  Save and Make Live and select Yes.

6.5 SNMP Alarm
The IP Office system can be configured to send alarms. These alarms can be sent from the IP Office using SNMP, SMTP e-
mail or Syslog alarm formats. This tab is used to sets the levels at which the voicemail server will indicate to the IP Office
to send an alarm. 

 To set up disk space and recording time alarms:

1.Display the main Voicemail Pro window.

2.From the Administration menu, select Preferences > General.
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3.Click the SNMP Alarm tab.

4.Choose the Alarm Threshold Unit either Disk Space Left (MB) or Recording Time left (minutes).

5.In the Alarm Threshold Level box, type the number of units (minutes or MB) left at which SNMP alarms are to be
triggered. The minimum is 11. This value also sets two further SNMP alarm levels which are:

· Space OK Alarm 
This alarm is triggered when the amount of available space returns to above a level set at Alarm Threshold
Level plus 30.

· Critical Alarm 
This alarm is set at 30 or, when the Alarm Threshold Level is less than 40, at Alarm Threshold Level minus 10.
Currently the critical alarm value will decrease in accordance with the above rule. Note however that it does not
increment upwards when the Alarm Threshold is increased again. To reset the critical alarm back to 30, click 
Default Settings.

6.To return to the default alarm settings, click Default Settings. The Alarm Threshold Level is reset to 60. The
Space OK level is reset to 90. The Critical Alarm level is reset to 30.

7.Click OK.

8.Click  Save and Make Live and select Yes.
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6.6 Outcalling
The outcalling preferences in Voicemail Pro are defaults for global operation. Mailbox owners can configure their own
outcalling options from their telephone, for example, create their own time profile. 

For details on configuring outcalling, refer Avaya IP Office Intuity Mailbox Mode User Guide (15-601130) and Avaya IP
Office Phone Manager User Guide (15-600988). 

A timeout value can also be set by a user. This is the duration for which outcalling will attempt to connect to a number
before giving up. 

To set the global outcalling preferences:

1.Display the main Voicemail Pro window.

2.From the Administration menu, select Preferences > General.

3.Click the Outcalling tab.

4.Select the times that outcalling is active in the System Times section.

· Prime Times 
The time period that outcalling is to be active as default for the system.

· Peak Times 
The busiest working hours.

5.Set the retry settings in the System Retry Settings section.

6.The Number of Retries can be between 0 and 10. If the message is not collected after the last retry, no
notification is sent until another new message is delivered in the user's mailbox.

7.The Retry Interval for each successive retry. The interval is the length of time between each attempt to connect
to the target number again. The 6th to 10th retries use the default retry interval.

8.Double-click a selected retry time to edit the interval between retries. The New interval number window opens
where the length of time between each attempt to ring the target number can be changed. Click OK to save the
change and return to the Outcalling window.

9.Click OK.

10.Click  Save and Make Live and select Yes.
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Chapter 7.
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7. Centralized Voicemail Pro
A Small Community Network (SCN) consists of several IP Office telephone systems. These are connected using H323
Lines where the Supplementary Services settings of the lines has been set to IP Office SCN. For details, refer to
Avaya IP Office Manager (15-601011). 

Within a Small Community Network, the following options for providing voicemail are supported:

· Centralized Voicemail  

Centralized Voicemail Pro uses a single Voicemail Pro server to provide
voicemail services for all IP Offices in the Small Community Network.
Except for use of ContactStore, only the central IP Office hosting the
voicemail server requires licensing for Voicemail Pro operation and
features.

· Licenses: The central IP Office is licensed as normal for Voicemail
Pro operation and the voicemail features required. The other IP
Offices only require licenses for UMS and or for ContactStore if
required. 

· Centralized Voicemail with Fallback IP Office  
Control of the voicemail server can be taken over by another IP Office if
the central IP Office becomes unavailable.

· IP Office Release 5.0+ with Voicemail Pro 5.0+. 

· Licenses: The fallback IP Office that takes over control of the
voicemail server requires licenses for Voicemail Pro operation and
the features required during fallback. 

· Centralized Voicemail with a Backup Voicemail Server  
The central IP Office hosting the voicemail server can be configured with
the IP address of a backup voicemail server. During normal operation,
call flows and other settings on the backup server are kept synchronized
with those of the primary voicemail server. If the primary voicemail
server becomes unavailable to the network, voicemail services are
provided by the backup voicemail server. 

· IP Office Release 6.0+ with Voicemail Pro 6.0+. 

· IIS SMTP is used to exchange information between the servers. 

· Licenses: The existing licenses are used. 

· Centralized Voicemail with Distributed Voicemail Servers  
Other IP Offices in the Small Community Network can host their own
Voicemail Pro server. That server is then used for the IP Office's
voicemail functions except message storage. 

· IP Office Release 6.0+ with Voicemail Pro 6.0+. 

· IIS SMTP is used to exchange information between the servers. 

· The distributed voicemail server provides all voicemail services
except voicemail collection for its associated IP Office. 

· Licenses: Each IP Office using a distributed voicemail server must
have licenses for Voicemail Pro operation and the voicemail features
required. 

In all the cases above, the central voicemail server remains the store for messages and recordings (except for Exchange
UMS users). The central voicemail server does message waiting indication and is the voicemail server used for message
collection. Only when the central server is temporarily unavailable will the backup or any distributed server do message
storage and collection. In those scenarios, when the central server is restored, messages collected by the backup or
distributed servers are forwarded to the central server. 

Combinations  of the solutions above can be deployed. For example using a backup server and fallback IP Office
control. 
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Centralized Voicemail Pro:  

7.1 Centralized Voicemail
Within a Small Community Network, a single Voicemail Pro server can be used to provide voicemail features for all the IP
Offices in the SCN. 

One IP Office is configured for operation with the Voicemail Pro server as normal, including the license for voicemail
operation and the features required. This IP Office is then regarded as the central IP Office for voicemail.

Within the other IP Office systems, the voicemail settings are configured to indicate that they get their voicemail services
from the central IP Office. These IP Offices do not need licenses for voicemail (except for ContactStore and or UMS if
required). 

With the International Time Zone functionality available on the central Voicemail Pro server, the users of the IP offices
located in different time zones across the globe receive messages in their voicemail system with their respective time
stamp. In the sample scenario, the three IP Offices located in different time zones connect to each other. Two of the IP
Offices are located in different geographical locations and are connected to the central IP Office. The Voicemail Pro server
connects to the central IP Office. In this setup, the system stores the voicemail messages on the centralized Voicemail
Pro. Each IP Office is set up to use Simple Network Time Protocol (SNTP) .

In the centralized Voicemail Pro setup, the time source of the IP Office network must be SNTP (Simple Network Time
Protocol). 

Simple Network Time Protocol (SNTP) is an Internet standard protocol (built on top of TCP/IP) that provides accurate
synchronization to the millisecond of computer clock times in a network of computers. It synchronizes all the IP Offices in
an SCN configuration.

Summary of IP Office Settings
Once the IP Office SCN has been setup, the following settings are used in the IP Office systems to provide voicemail
operation for all the IP Offices. 

IP Office Settings Central IP Office Other IP Offices

Voicemail Type Voicemail Pro Centralized Voicemail

Voicemail IP Address Set to the voicemail server computer's IP
address. 

Not used.

Voicemail Destination Not used. Set to the Outgoing Group ID of the H323
Line to the central IP Office. 

Licenses This system needs licenses  for all the
Voicemail Pro features required. 

The other IP Offices only require licenses for
UMS and or for ContactStore if required. 

When accessing a voicemail server that is acting as centralized voicemail server, the Voicemail Pro will display 
Centralized Voicemail in the title bar. 

12
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7.2 Fallback IP Office Control
IP Office Release 5.0+ supports a number of fallback features for Small Community Networks. In conjunction with
Voicemail Pro 5.0+, fallback can include one of the IP Offices assuming control of the voicemail server should the central
IP Office become unavailable on the network. 

Normal Operation 
During normal operation, voicemail services for the
Small Community Network are provided by the
central IP Office communicating with the voicemail
server. 

 

Fallback Control Operation 
If the central IP Office becomes unavailable to the
network, control of voicemail services for the Small
Community Network is taken over by the fallback IP
Office. 

· WARNING 
During the transition of voicemail control, access to voicemail may be unavailable for several minutes. Existing
voicemail calls are disconnected and new calls are routed as if voicemail is unavailable. The same applies when the
central IP Office is restored. 

Setup and Requirements for Voicemail Fallback

· Within the configuration of the central IP Office hosting the voicemail server, on the H323 Line to the fallback IP
Office;

· The Supplementary Services setting should be changed from IP Office - SCN to IP Office -SCN Fallback. 

· The option Backs up my Voicemail should then be selected from the SCN Backup Options. 

· The fallback IP Office is configured for centralized voicemail as normal. However its configuration must also include
licenses for the Voicemail Pro support and the voicemail features required during fallback. 
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7.3 Backup Voicemail Server Operation
For IP Office Release 6.0 and higher, the central IP Office hosting the Voicemail Pro server can be configured with the IP
address of a backup voicemail server. If the central voicemail server becomes unavailable to the network, the backup
server will be used to provide voicemail services. This option requires the voicemail servers to be running Voicemail Pro
6.0 or higher. 

Centralized voicemail with a backup server during normal
operation.

During Normal Operation: 

· Voicemail services and message storage for the IP
Offices is provided by the primary voicemail server. 

· Call flows and other settings configured on the backup
voicemail server are synchronized with those of the
central voicemail server. 

· Messages are synchronized but the central voicemail
server remains the message store accessed for
message collection. 

· The synchronization is done using IIS SMTP e-mail
between the servers.

Centralized voicemail with a backup server during backup
operation. 

During Backup Operation: 
If the central voicemail server become unavailable to the
network: 

· The backup voicemail server provides voicemail
services for the IP Offices. 

· New messages are left on the backup server.

After Backup Operation 
When the central server is restored to the network:

· It does not automatically resume control. However
messages and changes that occurred while it was
unavailable are synchronized from the backup server.

· If the backup server fails, the central sever resumes
control as the active server.

· Call flows defined on the central server are synchronized with the backup server.

· Call flows defined on the central server cannot be modified on the backup server.

· Call flows cannot be defined on the backup server.

· Call flows defined on a distributed server are not synchronized to the central or backup servers. 
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Configuring Backup Server Operation
1.The Voicemail Pro server software is installed as normal on the backup server computer. The voicemail server is not

specifically configured as being a backup server. 

2.The central IP Office hosting the primary voicemail server is configured with the IP addresses of both the primary
voicemail server and the backup voicemail server. 

3.The other IP Offices are configured for centralized or distributed voicemail as normal. 



Implementing Voicemail Pro on Linux Page 85
15-601065 Issue 02b (Friday, April 06, 2012)IP Office 8.0

Centralized Voicemail Pro: Backup Voicemail Server Operation

7.4 Distributed Voicemail Servers
For IP Office Release 6.0 and higher, remote IP Offices in the Small Community Network can be associated with another
voicemail server in addition to the centralized voicemail server. The additional distributed server then provides all
voicemail services (except message storage and collection) for that IP Office. This requires the remote IP Office to have
licenses for voicemail operation and the features it requires.

While the distributed server does message recording, it forwards all messages to the central voicemail server. The
messages are transferred between systems using an IIS SMTP e-mail services. For mailbox users, message waiting
indication and message collection is still done using the central voicemail server. With the support of International Time
Zone (ITZ) functionality, the users of the IP Offices located across the globe receive messages in their voicemail system
with their respective local time stamp.

Centralized Voicemail with Additional Distributed
Voicemail Servers 
In this scenario, the three IP Offices located in different
time zones connect to each other. Two of the IP Offices
are located in different geographical locations and are
connected to the Central IP Office. The Central IP Office
connects to a central Voicemail Pro server and the other
IP Offices connect to the Distributed Voicemail Pro server,
an additional voicemail server added to the Small
Community Network. Each IP Office is set up to use
Simple Network Time Protocol (SNTP), the time source of
the IP Office Network.

Simple Network Time Protocol (SNTP) is an Internet
standard protocol (built on top of TCP/IP) that provides
accurate synchronization to the millisecond of computer
clock times in a network of computers. It synchronizes all
the IP Offices in an SCN configuration.

· Other IP Offices continue to use centralized voicemail
as normal. 

· An IP Office that is using a distributed voicemail server
cannot also be used as the fallback IP Office  for the
central voicemail server.

· The synchronization is done using IIS SMTP e-mail
between the servers.

Note: In the distributed Voicemail Pro set up, ITZ
functions similar to the centralized Voicemail pro set up.

Multiple Distributed Servers 
Additional distributed voicemail servers can be added as
required by the individual IP Office sites in the Small
Community Network. 
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Sharing Distributed Voicemail Servers
The same distributed voicemail server can be shared by
several IP Offices. The services it provided to each will
depend on the licenses that each has. 

Summary of IP Office Configuration Settings for Distributed Voicemail Severs

IP Office
Settings

Central IP Office Other IP Offices IP Office with Distributed
Server

Voicemail
Type

Voicemail Pro Centralized Voicemail Distributed Voicemail

Voicemail IP
Address

Set to the central voicemail server
computer's IP address. 

Not used. Set to the distributed voicemail
server computer's IP address. 

Voicemail
Destination

Not used. Set to the Outgoing Group ID of
the H323 Line to the central IP
Office. 

Set to the Outgoing Group ID of
the H323 Line to the central IP
Office. 

Licenses This system needs licenses  for
Voicemail Pro and all voicemail
features required. 

The other IP Offices only require
licenses for UMS and or for
ContactStore if required. 

This system needs licenses  for
Voicemail Pro and all voicemail
features required. 

Configuring Distributed Voicemail Server Operation
1.The centralized voicemail server for the SCN and its central IP Office are configured as normal. 

2.The Voicemail Pro server software is installed as normal any distributed voicemail server computer. The distributed
voicemail server is not specifically configured as being a distributed server. 

3.Each IP Office hosting a distributed voicemail server is configured with the Voicemail Type set to Distributed
Voicemail. 

· The Voicemail Destination is set the Outgoing Group ID of the H323 trunk to the central IP Office hosting
the centralized voicemail server. 

· The Voicemail IP Address is set to the IP address of the computer running the distributed voicemail server
for the IP Office. 

12 12
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Centralized Voicemail Pro: Distributed Voicemail Servers

7.5 Combined Options
The various centralized voicemail options (standard, fallback, backup and distributed) can be used within the same Small
Community Network. 

· An IP Office using a distributed voicemail cannot be used as the fallback IP Office for the central IP Office. 

· A distributed voicemail server cannot also be used as the backup voicemail server. 
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Example: Combined Fallback Control and Backup Server Operation
In the example below the fallback IP Office control  and backup voicemail server  operation can be combined. 

Central Voicemail Server controlled by Fallback IP Office

· Central IP Office Unavailable 
If the central IP Office becomes unavailable on
the network, the fallback IP Office takes over
control of voicemail services using the
centralized voicemail server. 

Backup Voicemail Server controlled by Central IP Office

· Central Voicemail Unavailable 
If the central voicemail server becomes
unavailable on the network, the central IP
Office will switch to using the backup voicemail
server. 

Combined Backup Voicemail Server and Fallback IP Office Operation

· Central IP Office and Central Voicemail
Server Unavailable 
If both the central IP Office and the central
voicemail server become unavailable to the
network, voicemail services will switch to the
backup voicemail server under control of the
fallback IP Office. 
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Centralized Voicemail Pro: Combined Options

7.6 Installation Notes

SMTP Configuration
Both the distributed voicemail and backup voicemail scenarios use the same mechanism for the information exchange
between the servers. That mechanism uses SMTP e-mails between the IIS on each of the voicemail servers. Note that
this means a server with Microsoft Exchange installed (such as an SBS server) cannot be used as Exchange replaces the
IIS SMTP service. 

The following notes apply to both scenarios unless specifically stated as otherwise. 

1.Install and Enable IIS 
All the voicemail servers (central, distributed and backup) require IIS to be installed and enabled on the server
before installation of the Voicemail Pro server software. 

1.Start the Internet Information Services manager. 

2.Right-click on the Default SMTP Virtual Server and select Properties. 

3.Select the Messages tab. Deselect the Limit Message Size and Limit number of messages per connection
options. 

2.Configure Each Voicemail Pro Server for SMTP E-mail via IIS 
Following installation of the Voicemail Pro server software, its should be configured for SMTP e-mail operation as
follows:

a.By default the Voicemail Pro server installs defaulted to SMTP e-mail operation. However this should be
checked. 

1.Start the Voicemail Pro Client. Click  Preferences and select General.

2.Click the E-mail tab.

3.Verify that the MAPI  settings are not enabled. . 

4.Select the SMTP Sender  sub tab. The first entry in the list must be configured for SMTP between the
voicemail servers. Set the Domain and Server to the fully qualified domain name of the voicemail server. 
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· For a Windows based voicemail server, these e-mails will be received on port 25 by IIS and will be
placed in its mail drop folder. To obtain the name, right-click on My Computer and select Properties.
The Computer Name tab shows the information that should be used as Full computer name. The
name must be used, IP addresses are not used. 

5.Select the SMTP Receiver  sub tab. 

· For a Windows based server, set the SMTP Receiver as External and set the Drop Folder address to
be the IIS mail drop folder (usually C:\Inetpub\mailroot\Drop). For a Linux based server set the
SMTP Receiver as Internal. 

· Click OK. 

6.Click  Save & Make Live.

3.Verify that Port 25 is Not Blocked 
Many firewalls block access to port 25 by default. Check that the firewall software on the server is configured to
include VMProV5Svc.exe as an exception. 

4.DNS Host Routing (Optional) 
SMTP operation uses fully qualified domain names that need to be resolved to IP addresses by the network's DNS
server. For name resolution, the hosts files on each server can be used. Note however that if this method is used,
any changes to IP addresses of servers will need to be reflected in the file update. Locate the file C:
\Windows\System32\drivers\etc\hosts and open it in a text editor such as WordPad. Add IP address and fully
qualified domain name entries for each of the other  voicemailservers. 
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Centralized Voicemail Pro: Installation Notes

Voicemail Pro Configuration
In all scenarios, each Voicemail Pro server should use the same basic configuration settings, ie. the same voicemail mode
(Intuity or IP Office) and the same housekeeping settings. 

IP Office Configuration
Configuring Distributed Voicemail Server Operation

1.The centralized voicemail server for the SCN and its central IP Office are configured as normal. 

2.Each IP Office not hosting a distributed voicemail server is configured with the Voicemail Type set to Centralized
Voicemail. 

· The Voicemail Destination is set the Outgoing Group ID of the H323 trunk to the central IP Office hosting
the centralized voicemail server. 

Configuring Distributed Voicemail Server Operation

1.The centralized voicemail server for the SCN and its central IP Office are configured as normal. 

2.The Voicemail Pro server software is installed as normal any distributed voicemail server computer. The distributed
voicemail server is not specifically configured as being a distributed server. 

3.Each IP Office hosting a distributed voicemail server is configured with the Voicemail Type set to Distributed
Voicemail. 

· The Voicemail Destination is set the Outgoing Group ID of the H323 trunk to the central IP Office hosting
the centralized voicemail server. 

· The Voicemail IP Address is set to the IP address of the computer running the distributed voicemail server
for the IP Office. 

Configuring Backup Server Operation

1.The Voicemail Pro server software is installed as normal on the backup server computer. The voicemail server is not
specifically configured as being a backup server. 

2.The central IP Office hosting the primary voicemail server is configured with the IP addresses of both the primary
voicemail server and the backup voicemail server. 

3.The other IP Offices are configured for centralized or distributed voicemail as normal. 
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Check the Server Connections
1.Check Connection to the Central Server 

In the following tests, remember to use the fully qualified domain name of each server. 

a.Ping Test 
Make a ping from the server to the central server, for example ping vmpro1.example.com. You should see a
series of 4 successful replies from the sever.

b.Telnet Test 
Make a telnet test from the server to the central server, for example telnet vmpro1.example.com 25. You
should receive a response from the e-mail server within IIS. Enter quit to close the telnet connection. 

2.Check Connection from the Central Server 
Repeat the ping and telnet tests, this time from the central server to the backup or distributed server. 

Checking Status with the Voicemail Pro Client
When connected to a Voicemail Pro server using the Voicemail Pro client, the client title bar will display the role of that
voicemail server; Centralized Voicemail, Backup Voicemail or Distributed Voicemail. 

When connected to the backup voicemail server, if it is the active server, the title will have changed from Backup
Voicemail to Backup Voicemail (Live). 

When connected to the centralized voicemail server, the Distributed Voicemails folder can be selected to display
details of the distributed servers and the state of the connection with each. The Result will be either: 

· In Progress 
The servers are synchronizing information via SMTP. 

· Up-To-Date 
The servers are synchronized. 
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Appendix

Chapter 8.
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8. Appendix
8.1 SMTP Logging
SMTP error logging is enabled to generate a log of SMTP activity. 

For a Windows based Voicemail Pro installation, the activity is logged in a file in C:\Program Files\Avaya\IP
Office\Voicemail Pro\VM\logs. The file name includes a date stamp for the day on which it is generated. For a Linux
based server the log files can be archived and downloaded using the web control menus. 

8.2 Glossary

8.2.1 Centralized Voicemail Pro Server
Centralized Voicemail Pro uses a single Voicemail Pro server to provide voicemail services for all IP Offices in the Small
Community Network. Except for use of ContactStore, only the central IP Office hosting the voicemail server requires
licensing for Voicemail Pro operation and features.

8.2.2 Distributed Voicemail Pro Server
For IP Office Release 6.0 and higher, remote IP Offices in the Small Community Network can be associated with another
voicemail server in addition to the centralized voicemail server. The additional distributed server then provides all
voicemail services (except message storage and collection) for that IP Office. This requires the remote IP Office to have
licenses for voicemail operation and the features it requires.

8.2.3 MAPI
Message Application Programming Interface (MAPI) is a Microsoft Windows system architecture that supports adding
messaging functionality into applications. MAPI-enabled e-mail applications can share e-mails and also work together to
distribute the mail.

8.2.4 SNTP
Simple Network Time Protocol (SNTP) is an Internet standard protocol (built on top of TCP/IP) that provides accurate
synchronization to the millisecond of computer clock times in a network of computers. It synchronizes all the IP Offices in
an SCN configuration.

8.2.5 VPNM
Voicemail Private Networked Messaging (VPNM) is a set of preferences available only if you have selected VPNM during
installation and is licensed within the IP Office configuration. It is used to add a list of the remote VPNM servers and
mailbox users on those servers.

8.2.6 VRL
Using the Voice Recording Library (VRL) operation, Voicemail Pro can transfer specific users' automatic and/or manually
recorded calls to a third-party application. Users can select VRL as the destination for calls recorded via a Leave Mail
action in a call flow. 

Currently, this mode of operation is only supported with the Contact Store for IP Office application from Witness
Systems. This application provides tools to sort, search and playback recordings. It also supports the archiving of
recordings to DVD. 
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